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1 ИССЛЕДОВАНИЕ  УСТОЙЧИВОСТИ  И  ЗАКРИТИЧЕСКОГО 
ДЕФОРМИРОВАНИЯ  ЦИЛИНДРИЧЕСКОЙ  ПАНЕЛИ   
ПРИ  ПОМОЩИ  CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: цилиндрическая панель нагружена сосредоточенной 

силой P  в центре, как показано на рисунке 1.1; оболочка шарнирно оперта 

вдоль ее прямолинейных кромок и свободна вдоль криволинейных; материал 

линейно-упругий изотропный (модуль упругости 3,1·103 МПа; коэффициент 

Пуассона 0,3). 

Допущение: отношения наименьшей длины стороны панели и радиуса 

кривизны оболочки к толщине больше 10, что позволяет использовать для ее 

моделирования оболочечные элементы. 

Цель: 1) определить критическую нагрузку методом начальной устой-

чивости; 2) выполнить анализ с учетом геометрической нелинейности путем 

задания приращений нагрузки и определить верхнюю критическую нагрузку 

(сравнить с предыдущим решением); 3) выполнить анализ с учетом геомет-

рической нелинейности путем задания приращений перемещений и опреде-

лить верхнюю и нижнюю критические нагрузки; 4) исследовать закритиче-

ское поведение панели методом длины дуги. 

 

 
Рисунок 1.1 – Геометрия оболочки 
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Благодаря двойной симметрии конструкции и нагрузки здесь можно 

ограничиться рассмотрением лишь четверти панели. При этом вместо силы 

P  нужно будет прикладывать силу  P/4. 

Для решения задачи предлагается выполнить следующие действия. 

 

I. Метод начальной устойчивости. 
1. Запустить пакет ANSYS, указать имя задачи Lab1. 

2. Установить тип используемых в расчете элементов – 4-узловой оболочеч-

ный элемент SHELL63: M_M>Preprocessor>Element Type>Add/Edit/Delete. 

Нажимаем Add и выбираем Structural Shell>Elastic 4node 63, OK и Close. 

3. Определить реальные постоянные для выбранного типа элементов: M_M> 

Preprocessor>Real Constants>Add/Edit/Delete. 

Нажимаем Add и указываем тип элементов «Type 1 Shell63», OK. 

В соответствующие поля вводим: 

«Real Constant Set No»: 1 (номер набора реальных постоянных) 

«Shell thickness at node I» TK(I): 12.7 (толщина оболочки, мм) 

OK. 

Закрываем диалоговую панель кнопкой Close. 

4. Задать свойства материала: M_M>Preprocessor>Material Props>Material 

Models. 

В правом окне последовательно (двойным щелчком мыши) выбираем 

Structural>Linear>Elastic>Isotropic. 

Вводим: 

EX: 3.1e3 (модуль упругости, МПа) 

PRXY: 0.3 (коэффициент Пуассона) 

OK. 

Закрываем панель. 

5. Для удобства ввода исходных данных определить скалярные параметры: 

U_M>Parameters>Scalar Parameters. 

В поле «Selection» последовательно вводим: R=2540; L=508; pi=acos(-1); 

theta=0.1*180/pi. После каждого ввода здесь необходимо нажать кнопку 

Accept (принять). 

Закрываем панель кнопкой Close. 

6. Построить точки: M_M>Preprocessor>Modeling>Create>Keypoints>In  

Active CS. 
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Вводим координаты точек (используя буквенные обозначения скалярных 

параметров) согласно следующей таблице: 

 

Номер  
точки 

x, 
 мм 

y, 
 мм 

z, 
 мм 

1 0 0 0 
2 0 0 / 2L  
3 0 R 0 

 

Включаем нумерацию геометрических объектов: U_M>PlotCtrls>  

Numbering, отмечаем флаги «Keypoint numbers», «Line numbers» и «Area 

numbers». 

Для лучшего обзора точек установить с помощью кнопки Isometric View 

панели управления видом изометрическую проекцию. 

Первые две точки здесь являются вспомогательными, они будут исполь-

зоваться для определения оси вращения и траектории вытягивания. Третья 

точка представляет собой центральную точку панели. 

7. Построить дугу окружности путем вращения точки 3 относительно оси, 

заданной точками 1 и 2, на угол θ : M_M>Preprocessor>Modeling> 

Operate>Extrude>Keypoints>About Axis. 

При этом необходимо указать курсором мыши сначала точку 3, а затем 

после нажатия кнопки OK точки 1 и 2. 

Далее в поле «Arc length in degrees» (длина дуги в градусах) вводим отри-

цательное значение -theta (направление вращения здесь определяется пра-

вилом правого винта). OK. 

Отображаем на экране все объекты (команда U_M>Plot>Multi-Plots) и ус-

танавливаем подходящий масштаб (кнопка Fit View панели управления 

видом). 

8. Определить траекторию вытягивания путем построения прямой линии по 

точкам 1 и 2: M_M>Preprocessor>Modeling>Create>Lines>Lines>Straight 

Line. 

Указываем точки 1 и 2, OK. 

9. Построить цилиндрическую поверхность путем вытягивания дуги вдоль 

заданной траектории: M_M>Preprocessor>Modeling>Operate>Extrude> 

Lines>Along Lines. 

Сначала указываем дугу (линия L1), а затем после нажатия кнопки OK – 

траекторию (линия L2). OK. 
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10. Удалить вспомогательные геометрические объекты (т.е. линию L2 и при-

надлежащие ей точки 1 и 2): M_M>Preprocessor>Modeling>Delete>Line 

and Below. 

Указываем линию L2, OK. 

Для отображения поверхности выбираем последовательность U_M>Plot> 

Areas (рисунок 1.2). 

 

 
Рисунок 1.2 – Цилиндрическая поверхность 

 

11. Разбить поверхность на конечные элементы: M_M>Preprocessor> 

Meshing>MeshTool. 

Следует отметить, что для получения результатов приемлемой точности 

здесь достаточно построить сетку 8х8. 

Для этого нажимаем кнопку Set строки «Global» и в поле «No. of element 

divisions» (число делений линий на элементы) вводим значение 8. 

Затем в списке «Mesh» в качестве объектов для разбиения выбираем Areas 

(поверхности), в поле «Shape» (форма элементов) указываем Quad (четы-

рехугольная). 

Устанавливаем режим Mapped (регулярная сетка). 

Для генерации сетки нажимаем кнопку Mesh и указываем поверхность A1, 

OK. 

12. Задать граничные условия симметрии: M_M>Solution>Define Loads>  

Apply>Structural>Displacement>Symmetry B.C. >...with Area. 
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Cначала указываем линию L1 (см. рисунок 1.2), выбор фиксируем кноп-

кой OK. 

Затем указываем прилегающую к линии поверхность A1, нажимаем Apply 

для продолжения работы с данной командой. 

Условия симметрии на линии L4 задаются аналогично. 

13. Задать граничные условия шарнирного опирания на прямолинейной 

кромке: M_M>Solution>Define Loads>Apply>Structural>Displacement>On 

Lines. 

Указываем линию L5 (см. рисунок 1.2) и после нажатия кнопки OK выби-

раем компоненту UX (поступательное перемещение по оси x ). Apply. 

Поскольку при задании граничных условий на линиях можно выбрать 

только одну компоненту (или сразу все), необходимо повторить данные 

действия еще дважды, указывая компоненты UY и UZ. 

14. Задать сосредоточенную силу в центре панели: M_M>Solution>Define 

Loads>Apply>Structural>Force/Moment>On Keypoints. 

Поскольку значение силы нам неизвестно, зададим единичную нагрузку, 

например P  = 1 кН. 

Сначала указываем точку 3 (см. рисунок 1.2), OK. 

Затем в списке «Direction of force/mom» (направление силы/момента) вы-

бираем строку FY и в поле «Force/moment value» (значение силы/момента) 

вводим число -250 (знак минус говорит о том, что сила действует против 

оси). 

Напомним, что здесь мы задаем не полную силу, а P/4. 

15. Выполнить линейный статический анализ (первый этап). 

Как отмечалось ранее, задача начальной устойчивости решается в два эта-

па. Сначала проводится линейный статический анализ, а затем решается 

проблема собственных значений. 

Проверяем, установлен ли статический анализ (команда M_M>Solution> 

Analysis Type>New Analysis). 

Далее в меню выбираем последовательность M_M>Solution>Analysis 

Type>Sol’n Controls; включаем опцию «Calculate prestress effects» для соз-

дания начальных напряжений. 

И, наконец, посылаем задачу на счет: M_M>Solution>Solve>Current LS. 

По окончании статического анализа следует выйти из решателя (команда 

M_M>Finish). 

16. Выполнить анализ начальной устойчивости (второй этап). 
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Сначала с помощью команды M_M>Solution>Analysis Type>New Analysis 

выбираем тип анализа Eigen Buckling (анализ начальной устойчивости). 

Далее для задания опций анализа используем команду: M_M>Solution> 

Analysis Type>Analysis Options. 

В поле «No. of modes to extract» (число извлекаемых собственных значе-

ний и векторов) вводим число 1. 

Остальные значения данной и следующей диалоговых панелей принимаем 

по умолчанию (нажатием кнопки OK). 

Снова посылаем задачу на счет: M_M>Solution>Solve>Current LS. 

17. Определить критическую силу: M_M>General Postproc>Result Summary. 

На экране появляется список, где во втором столбце, содержатся собст-

венные значения (в нашем случае только одно, наименьшее): 

SET   TIME/FREQ    LOAD STEP   SUBSTEP  CUMULATIVE 
 1     10.620          1          1         1 

Для рассматриваемой задачи  1 10,62λ =  и, следовательно,  

кр 1 10,62P Pλ= = кН. 

Можно ли доверять данному решению? Ответить на этот вопрос можно 

лишь, выполнив нелинейный анализ. 

18. Отобразить на экране дисплея форму потери устойчивости. 

Сначала нужно считать из файла результаты расчета, соответствующие 

второму этапу: M_M>General Postproc>Read Results>Last Set. 

Далее для вывода данного изображения используем команду M_M>  

General Postproc>Plot Results>Deformed Shape. 

Форма потери устойчивости рассматриваемой конструкции представлена 

на рисунке 1.3. 

Видно, что панель при потере устойчивости прогибается навстречу при-

ложенной силы. Это связано с тем, что собственный вектор (характери-

зующий в данном случае форму потери устойчивости) даже после норми-

рования определяется с точностью до знака. 

Таким образом, абсолютные значения перемещений, а также их знак здесь 

не имеют физического смысла. 
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Рисунок 1.3 – Форма потери устойчивости 

 

 

II.  Геометрически нелинейный анализ (задание приращений нагрузки). 

19. Увеличить значение сосредоточенной силы: M_M>Solution>Define Loads> 

Apply> Structural>Force/Moment>On Keypoints. 

Анализ начальной устойчивости показывает, что критическая нагрузка 

значительно превышает заданную силу в 1 кН. 

Увеличим нагрузку до 4 кН. 

Для этого сначала указываем точку 3, а затем для силы FY  вместо значе-

ния -250 вводим -1000. OK. 

20. Выполнить геометрически нелинейный анализ. 

Сначала с помощью команды  M_M>Solution>Analysis Type>New Analysis  

устанавливаем статический анализ (Static).  

Далее меняем опции анализа: M_M>Solution>Analysis Type>Sol’n Controls. 

При этом появляется диалоговая панель с большим количеством вкладок. 

Выбираем вкладку «Basic» (рисунок 1.4). 

Для учета больших перемещений в списке «Analysis Options» выбираем 

значение Large Displacement Static. 

Время в конце шага нагружения (поле «Time at end of loadstep» раздела 

«Time Control») задаем равным 1. 

Таким образом, время t  будет меняться в интервале от 0 до 1. В статиче-

ском анализе данная переменная является фактически параметром нагру-

жения, т.е. нагрузка в момент времени t  будет определяться равенством 
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tP P t= ⋅ , 

где P  – заданная нагрузка (в нашем случае 4 кН).  

 

 
Рисунок 1.4 – Задание опций нелинейного анализа 

 

С целью повышения точности расчета интервал изменения параметра t  

(процесс нагружения) делится на ступени (или подшаги) нагружения. 

В поле «Number of substeps» раздела «Time Control» вводим число подша-

гов, например 25. 

Здесь следует отметить, что чем больше подшагов, тем точнее получается 

решение. Обычно число подшагов выбирается из тех соображений, чтобы 

в пределах каждого подшага перемещения были малы по сравнению с 

размерами тела. 

И, наконец, для сохранения промежуточных результатов на всех подшагах 

в списке «Frequency» (частота записи выходных величин в файл результа-

тов) выбираем значение Write every substep. 

После задания опций нелинейного анализа задача посылается на счет: 

M_M>Solution>Solve>Current LS. 

21. Определить верхнюю критическую нагрузку. 

Входим в постпроцессор истории нагружения: M_M>TimeHist Postpro. 

При этом автоматически появляется диалоговая панель для работы с пе-

ременными (рисунок 1.5). По умолчанию здесь определена только одна 

переменная TIME (время). 
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Рисунок 1.5 – Работа с переменными в постпроцессоре истории нагружения 

 

Для задания новой переменной нажимаем кнопку Add Data (первая слева в 

панели инструментов). 

При этом появляется диалоговая панель, где в списке выходных величин 

«Result Item» последовательно указываем Nodal Solution>DOF Solution> 

Y-Component of displacement (перемещение по оси y ). 

В поле «Variable Name» (имя переменной) вводим Uy. OK. 

Далее на экране при помощи мыши указываем узел в центре панели, где 

приложена сила. OK. 

После этого в списке существующих переменных появляется новая за-

пись. 

Для просмотра значений заданной переменной в текстовом формате ее 

нужно указать в списке и нажать кнопку List Data (четвертая слева в пане-

ли инструментов): 
  TIME             Uy   
0.40000E-01   -0.410742 
0.80000E-01   -0.838741 
0.14000        -1.51760 
0.23000        -2.63748 
0.36500        -4.65229 
0.45613        -6.44437 
0.54725        -9.31290 
0.55971        -10.2799 
0.56531        -10.9587 
0.56645        -10.8204 
0.56758        -27.2309 
0.56928        -27.2438 
0.57184        -27.2678 
0.57567        -27.3037 
0.58141        -27.3574 
0.59003        -27.4373 



 12

0.60296        -27.5559 
0.62235        -27.7312 
0.65144        -27.9886 
0.69508        -28.3628 
0.76053        -28.9001 
0.85871        -29.6589 
1.0000         -30.6656 

 

Видно, что после 0,56645t =  происходит скачкообразное увеличение про-

гиба, т.е. оболочка теряет устойчивость с перескоком. Иногда при этом 

значении силы решение расходится. 

Таким образом, верхняя критическая нагрузка в
крP  для рассматриваемой 

конструкции составляет 4 0,56645 2,27⋅ = кН, что почти в пять раз меньше 

критической нагрузки 0
крP , найденной методом начальной устойчивости. 

Таким образом, метод начальной устойчивости для решения подобных за-

дач не применим!!! 

22. Построить кривую равновесных состояний. 

Для изображения зависимости «сила – перемещение» в привычном виде 

введем новые переменные на основе существующих с помощью калькуля-

тора диалоговой панели постпроцессора истории нагружения (рису-

нок 1.5). 

В первом поле калькулятора перед знаком равенства вводим имя новой 

переменной: P. 

Ниже расположены два списка, причем из второго можно выбирать вве-

денные ранее переменные. Выбираем TIME. 

Данная величина появляется в поле после знака равенства. 

Далее, используя кнопки калькулятора, выполняем умножение на 4 (т.к. 

заданная сила равна 4 кН). 

Завершаем ввод нажатием кнопки Enter. 

Для следующей переменной задаем имя W, затем в поле после знака ра-

венства ставим минус и в расположенном ниже списке выбираем значение 

Uy. 

В столбце «X-Axis» списка «Variable List» для переменной W устанавли-

ваем признак использования ее в качестве оси абсцисс. 

Далее в этом же списке указываем переменную P и нажимаем кнопку 

Graph Data (третья слева в панели инструментов). 

Отображаемый при этом график представлен на рисунке 1.6. 
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Рисунок 1.6 – Зависимость сила – перемещение, получаемая при задании  

приращений нагрузки 
 

Видно, что при задании приращений нагрузки нельзя построить полную 

кривую равновесных состояний, поскольку данный прием не позволяет 

проходить через предельные точки. В этих точках матрица тангенциаль-

ной жесткости сингулярная, и решение либо расходится, либо происходит 

перескок на другую устойчивую ветвь кривой равновесных состояний (как 

в нашем случае). 

 

III.  Геометрически нелинейный анализ (задание приращений  
       перемещений). 

23. Удалить нагрузку: M_M>Solution>Define Loads>Delete>Structural>Force/ 

Moment>On Keypoints. 

Указываем точку 3, OK. 

После этого появляется диалоговая панель, где необходимо выбрать на-

правление удаляемой силы (в нашем случае FY, хотя можно оставить зна-

чение по умолчанию ALL, означающее, что будут удалены все силы, дей-

ствующие в указанной точке). OK. 

24. Вместо силы приложить в центральной точке перемещение: M_M>  

Solution>Define Loads>Apply>Structural>Displacement>On Keypoints. 

Снова указываем точку 3, OK. 
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В списке «DOFs to be constrained» выбираем компоненту UY и в поле 

«Displacement value» вводим отрицательное значение -30 (в мм). 

OK. 

25. Выполнить геометрически нелинейный анализ. 

Заданные ранее опции анализа в основном нас устраивают. Поменяем 

лишь число подшагов и отключим опцию автоматического изменения ша-

га: M_M>Solution>Analysis Type>Sol’n Controls.  

Выбираем вкладку «Basic» и в поле «Number of substeps» вводим число 30. 

В поле «Automatic time stepping» (автоматическое изменение шага по вре-

мени) вместо значения Prog chosen (выбирается программой) указываем 

Off (отключить). При этом будет использоваться постоянный шаг по вре-

мени (нагрузке). 

Посылаем задачу на счет: M_M>Solution>Solve>Current LS. 

26. Построить кривую равновесных состояний. 

Входим в постпроцессор истории нагружения: M_M>TimeHist Postpro. 

Для задания новой переменной нажимаем кнопку Add Data. 

В древовидной структуре «Result Item» последовательно указываем  

Reaction Forces>Structural Forces>Y-Component of force (реакция по 

оси y ). 

В поле «Variable Name» вводим имя Ry. OK. 

Далее на экране мышью указываем узел в центре панели, где приложена 

сила. OK. 

С помощью калькулятора определим новые переменные. 

В первом поле калькулятора перед знаком равенства вводим имя W. 

После знака равенства вводим число 30 (заданное перемещение) и нажи-

маем кнопку умножения калькулятора. После этого из списка калькулято-

ра выбираем TIME. Завершаем ввод нажатием кнопки Enter. 

Для следующей переменной определяем имя P, затем в поле после знака 

равенства вводим: -0.004 (для получения значений силы для полной кон-

струкции в кН), затем нажимаем кнопку умножения и в списке выбираем 

переменную Ry. 

В столбце «X-Axis» списка «Variable List» для переменной W устанавли-

ваем признак использования ее в качестве оси абсцисс. 

Далее выбираем переменную P и нажимаем кнопку Graph Data. 

Получаемый в этом случае график показан на рисунке 1.7. 

 



 15

 
Рисунок 1.7 – Зависимость сила – перемещение, получаемая при задании  

приращений перемещений 
 

27. Определить верхнюю и нижнюю критические нагрузки. 

Оставаясь в постпроцессоре истории нагружения, нажимаем кнопку List 

Data: 
   TIME            P    
0.33333E-01    0.378526 
0.66667E-01    0.720438 
0.10000         1.02700 
0.13333         1.29922 
0.16667         1.53774 
0.20000         1.75923 
0.23333         1.93177 
0.26667         2.06904 
0.30000         2.16991 
0.33333         2.23118 
0.36667         2.24776 
0.40000         2.21172 
0.43333         2.06778 
0.46667         1.86789 
0.50000         1.56015 
0.53333         1.17250 
0.56667        0.828485 
0.60000        0.617896 
0.63333        0.526659 
0.66667        0.525477 
0.70000        0.596451 
0.73333        0.729056 
0.76667        0.890694 
0.80000         1.13421 
0.83333         1.44735 
0.86667         1.78666 
0.90000         2.17501 
0.93333         2.61268 
0.96667         3.10033 
1.0000          3.63885 
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Анализ полученных данных показывает, что сила сначала возрастает до 

некоторого значения, которое характеризует верхнюю критическую на-

грузку, затем убывает до значения, соответствующего нижней критиче-

ской нагрузке, после чего снова возрастает. 

Таким образом, для рассматриваемой конструкции в
крP =  2,25 кН  и  н

крP =  

0,53 кН. Здесь для верхней критической нагрузки получается более точное 

значение. 

Напомним, что данный прием имеет ряд существенных ограничений. Он 

применим лишь в случае действия сосредоточенной нагрузки и не позво-

ляет определять участки кривой равновесных состояний, не однозначные 

по перемещению. 

 

IV.  Использование метода длины дуги. 

28. Удалить заданное в центральной точке перемещение: M_M>Solution>  

Define Loads>Delete>Structural>Displacement>On Keypoints. 

Указываем точку 3, OK. 

В списке «DOFs to be deleted» выбираем UY (направление удаляемого пе-

ремещения), OK. 

29. Снова задать сосредоточенную силу в центре панели: M_M>Solution>  

Define Loads>Apply> Structural>Force/Moment>On Keypoints. 

Здесь также необходимо сначала указать точку 3, а затем для силы FY  

ввести значение -1000. 

30. Включить метод длины дуги: M_M>Solution>Analysis Type>Sol’n Controls. 

Выбираем вкладку «Advanced NL» и активизируем опцию «Active arc-

length method». Появляющееся при этом предупреждение можно проигно-

рировать; закрываем его кнопкой Close. 

В поле «Max multiplier» (максимальный множитель) вводим значение 4, а 

в поле «Min multiplier» (минимальный множитель) – значение 0.1. 

Данные параметры используются для задания пределов изменения длины 

дуги от одного подшага к другому, т.е. в случае хорошей сходимости дли-

на дуги может за один подшаг увеличиться максимум в четыре раза, а при 

плохой – уменьшиться максимум в десять раз. 

OK. 

31. Выполнить нелинейный анализ с использованием метода длины дуги: 

M_M> Solution>Solve>Current LS. 
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32. Построить кривую равновесных состояний. 

Входим в постпроцессор истории нагружения: M_M>TimeHist Postpro. 

Для определения переменной нажимаем кнопку Add Data. 

В качестве выходной величины выберем перемещение по оси y  (Nodal 

Solution>DOF Solution>Y-Component of displacement) в узле в центре пане-

ли. Присвоим ей имя Uy. 

В первом поле калькулятора перед знаком равенства вводим имя новой 

переменной P. Из списка калькулятора выбираем TIME и выполняем ум-

ножение данной переменной на 4. Завершаем ввод нажатием кнопки 

Enter. 

Для следующей переменной задаем имя W, затем в поле после знака ра-

венства ставим минус и в списке выбираем значение Uy. 

В списке «Variable List» для переменной W устанавливаем признак ис-

пользования ее в качестве оси абсцисс. 

Далее выбираем переменную P и нажимаем кнопку Graph Data. 

Кривая равновесных состояний  будет иметь точно такой же вид, как и на 

рисунке 1.7. 

33. Для отчета по работе записать в файл протокол команд базы данных: 

U_M>File>Write DB Log File. 

Вводим имя Lab1.lgw. 

34. Выйти из программы: ANSYS Toolbar>QUIT. 

 

 

 

Дополнительное задание: найти верхнюю и нижнюю кри-

тические силы для цилиндрической панели, представленной на 

рисунке 1.1, но с толщиной h =  6,3 мм. Кривую равновесных со-

стояний записать в файл  Lab1000.png: U_M>PlotCtrls>Hard 

Copy>To File. При этом использовать установки, как показано на 

рисунке справа. 
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2 ИССЛЕДОВАНИЕ  УСТОЙЧИВОСТИ  И  ЗАКРИТИЧЕСКОГО 
ДЕФОРМИРОВАНИЯ  ЦИЛИНДРИЧЕСКОЙ  ПАНЕЛИ   
ПРИ  ПОМОЩИ  CAE-СИСТЕМЫ  MSC.PATRAN/NASTRAN 

 

Исходные данные: цилиндрическая панель нагружена сосредоточенной 

силой P  в центре, как показано на рисунке 2.1; оболочка шарнирно оперта 

вдоль ее прямолинейных кромок и свободна вдоль криволинейных; материал 

линейно-упругий изотропный (модуль упругости 3,1·103 МПа; коэффициент 

Пуассона 0,3). 

Допущение: отношения наименьшей длины стороны панели и радиуса 

кривизны оболочки к толщине больше 10, что позволяет использовать для ее 

моделирования оболочечные элементы. 

Цель: 1) определить критическую нагрузку методом начальной устой-

чивости; 2) выполнить анализ с учетом геометрической нелинейности путем 

задания приращений нагрузки и определить верхнюю критическую нагрузку 

(сравнить с предыдущим решением); 3) выполнить анализ с учетом геомет-

рической нелинейности путем задания приращений перемещений и опреде-

лить верхнюю и нижнюю критические нагрузки; 4) исследовать закритиче-

ское поведение панели методом длины дуги. 

 

 
Рисунок 2.1 – Геометрия оболочки 

 

R= 2540 мм 

h= 12,7 мм 

P  

θ  θ  

x  

y  

z  

L = 508 мм 

θ  = 0,1 рад 
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Благодаря двойной симметрии конструкции и нагрузки здесь можно 

ограничиться рассмотрением лишь четверти панели. При этом вместо силы 

P  нужно будет прикладывать силу  P/4. 

Для решения задачи предлагается выполнить следующие действия. 

 

I. Метод начальной устойчивости. 
1. Запустить пакет MSC.Patran и открыть новую базу данных: File>New. 

В поле «File name» указываем имя файла базы данных Lab2.db, OK. 

2. Задать начальные установки. 

В разделе «Tolerance» диалоговой панели «New Model Preference» выби-

раем опцию «Based on Model» (на основе модели) и в поле «Model Dimen-

sion» (габаритный размер модели) вводим значение 254 (в мм), OK. 

3. Построить точку в центре цилиндрической панели. 

Выбираем приложение «Geometry» и для построения точки по трем коор-

динатам устанавливаем сочетание Create/Point/XYZ. 

Вводим: 

 «Point Coordinate List»: [0 2540 0] 

Apply. 

Включаем нумерацию геометрических объектов (кнопка Label Control па-

нели инструментов). 

4. Построить дугу окружности путем вращения точки 1 относительно оси Z 

на угол θ . 

Устанавливаем сочетание Create/Curve/Revolve. 

Вводим: 

 «Axis»: Coord 0.3 (ось вращения – ось Z) 

 «Total Angle»: -5.73 (полный угол, град) 

 «Offset Angle»: 0 (отступ угла, град). 

Направление вращения здесь определяется правилом правого винта. 

Активизируем поле «Point List» и в графическом окне указываем точку 1. 

Если отключена опция «Auto Execute», нажимаем Apply. 

С помощью кнопок  Iso 1 View и Smooth Shaded панели инструментов ус-

танавливаем изометрическую проекцию и изображение модели с закра-

шенными гранями и тенями. 

5. Построить цилиндрическую поверхность путем вытягивания дуги в за-

данном направлении. 

Устанавливаем сочетание Create/Surface/Extrude. 
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В поле «Translation Vector» вводим компоненты вектора смещения (в мм):  

<0 0 254>. 

Активизируем поле «Curve List» и в графическом окне указываем кри-

вую 1 (построенную на предыдущем шаге дугу). 

Если отключена опция «Auto Execute», нажимаем Apply. 

6. Разбить поверхность на конечные элементы. 

Следует отметить, что для получения результатов приемлемой точности 

здесь достаточно построить сетку 8х8. 

Выбираем приложение «Elements».  

Сначала для задания равномерного расположения опорных точек сетки 

устанавливаем сочетанием Create/Mesh Seed/Uniform. 

Используя опцию «Number of Elements», вводим число элементов: Number 

= 8. 

Активизируем поле «Curve List» и указываем две смежные кромки. При 

необходимости нажимаем  Apply. 

Далее для нанесения сетки на поверхность устанавливаем сочетание  

Create/Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad (четырехугольная форма) 

 «Mesher»: IsoMesh (генератор регулярных изосеток) 

 «Topology»: Quad4 (топология – четырехугольник с четырьмя узлами). 

Активизируем поле «Surface List» и в графическом окне указываем по-

верхность 1, Apply. 

7. Задать свойства материала. 
Запускаем приложение «Materials» и выбираем сочетание Create/Isotropic/ 

Manual Input. 

В поле «Material Name» вводим имя материала, например mater. 

Далее нажимаем кнопку Input Properties и вводим свойства: 

 «Elastic Modulus» = 3.1e3 (модуль упругости, МПа) 

 «Poisson Ratio» = 0.3 (коэффициент Пуассона) 

 OK. 

Нажимаем кнопку Apply. 

8. Определить свойства элементов. 
Выбираем приложение «Properties». Для задания свойств оболочечных 

элементов устанавливаем сочетание Create/2D/Shell. 

В поле «Property Set Name» вводим имя набора свойств, например panel. 
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Не меняя установленные по умолчанию опции, нажимаем кнопку Input 

Properties. 

Нажимаем кнопку     и из списка существующих материалов выбираем 

mater. 

В поле «Thickness» вводим значение толщины: 12.7 (в мм). 

Закрываем окно кнопкой OK. 

Нажимаем кнопку Select Application Region и указываем поверхность 1. 

Затем последовательно нажимаем  Add, OK и  Apply. 

9. Задать граничные условия симметрии. 

Напомним, что здесь для узлов, расположенных в плоскости симметрии, 

необходимо закрепить поступательное перемещение в направлении, пер-

пендикулярном этой плоскости, и два угла поворота относительно осей, 

параллельных данной плоскости. 

Сначала при помощи кнопки Top view панели инструментов устанавлива-

ем вид сверху, т.е. на плоскость XZ. 

Запускаем приложение «Loads/BCs» и для задания перемещений выбира-

ем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя вновь создаваемого набора, например 

sym_x. 

Нажимаем кнопку Input Data (ввод данных). 

В поле «Translations» (поступательные перемещения) вводим <0,,>, что 

соответствует 0xu = . 

В поле «Rotations» (углы поворота) вводим <,0,0>, что соответствует 

0y zϑ ϑ= = . OK. 

Далее нажимаем кнопку Select Application Region. Для выбора геометриче-

ских объектов устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (кривая или кромка) и указываем левую 

кромку (Surface 1.3). 

Последовательно нажимаем Add, OK и Apply. 

Аналогично определяем второй набор граничных условий симметрии для 

узлов, расположенных в плоскости XY. Присвоим ему имя sym_z. 

При этом для поступательных перемещений вводим <,,0>, а для углов по-

ворота – <0,0,>. 

В качестве области приложения здесь выбираем верхнюю кромку (Sur-

face 1.4 или Curve 1). 
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10. Задать граничные условия шарнирного опирания на прямолинейной 

кромке. 

В поле «New Set Name» вводим новое имя, например hinge. 

Нажимаем кнопку Input Data. 

В поле «Translations» вводим <0,0,0>, OK. 

Далее нажимаем кнопку Select Application Region и указываем правую 

кромку (Surface 1.1). 

Последовательно нажимаем Add, OK и Apply. 

11. Задать сосредоточенную силу в центре панели. 

Поскольку значение силы нам неизвестно, зададим единичную нагрузку, 

например P  = 1 кН. 

В том же приложении выбираем сочетание Create/Force/Nodal. 

В поле «New Set Name» вводим имя нового набора, например load. 

Нажимаем кнопку Input Data и в поле «Force» для задания силы, дейст-

вующей в отрицательном направлении оси Y, вводим следующие компо-

ненты (в Н): <0 -250 0>. OK. 

Необходимо напомнить, что здесь мы задаем не полную силу, а  P/4. 

Далее нажимаем кнопку Select Application Region. Для выбора геометриче-

ских объектов устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку     (точка или вершина) и указываем левую 

верхнюю вершину (Point 1, Curve 1.2 или Surface 1.3.1). 

Последовательно нажимаем кнопки Add, OK и  Apply. 

В конце устанавливаем изометрическую проекцию. 

12. Выполнить анализ начальной устойчивости. 

Запускаем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Для изменения типа решения нажимаем кнопку Solution Type и выбираем 

Buckling (анализ начальной устойчивости), OK. 

Для запуска задачи на счет нажимаем кнопку Apply основной диалоговой 

панели приложения. 

13. Присоединить файл результатов расчета к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчета устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 
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Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

lab2.xdb, OK. 

В заключение нажимаем Apply. 

14. Определить критическую силу. 

Запускаем приложение «Results». Для быстрого изображения результатов 

используем сочетание Create/Quick Plot. 

Собственное значение здесь приводится в списке «Select Result Cases» по-

сле названия второго случая результатов: 

Factor = 10.646. 

Таким образом, для рассматриваемой задачи  1 10,65λ =  и, следовательно,  

кр 1 10,65P Pλ= = кН. 

Можно ли доверять данному решению? Ответить на этот вопрос можно 

лишь, выполнив нелинейный анализ. 

15. Отобразить на экране дисплея форму потери устойчивости. 

В списке «Select Result Cases» указываем второй случай результатов. 

В списке «Select Deformation Result» в качестве результата для изображе-

ния деформированного состояния модели выбираем строку Eigenvectors, 

Translational. Apply. 

Форма потери устойчивости рассматриваемой конструкции представлена 

на рисунке 2.2. 

 

 
Рисунок 2.2 – Форма потери устойчивости 

 

Видно, что панель при потере устойчивости прогибается навстречу при-

ложенной силы. Это связано с тем, что собственный вектор (характери-
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зующий в данном случае форму потери устойчивости) даже после норми-

рования определяется с точностью до знака. 

Таким образом, абсолютные значения перемещений, а также их знак здесь 

не имеют физического смысла. 

 

II.  Геометрически нелинейный анализ (задание приращений нагрузки). 

16. Увеличить значение сосредоточенной силы. 

Анализ начальной устойчивости показывает, что критическая нагрузка 

значительно превышает заданную силу в 1 кН. 

Увеличим нагрузку до 4 кН. 

Запускаем приложением «Loads/BCs» и для изменения нагрузки выбираем 

сочетание Modify/Force/Nodal. 

В списке «Select Set to Modify» указываем набор load. 

Нажимаем кнопку Modify Data и в поле «Force» вводим <0 -1000 0>. OK. 

В конце нажимаем Apply.  

17. Выполнить геометрически нелинейный анализ. 

Запускаем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Для изменения типа решения нажимаем кнопку Solution Type и выбираем 

Nonlinear Static (нелинейный статический анализ), OK. 

Затем для модификации расчетного случая нажимаем кнопку Subcases. 

В списке доступных расчетных случаев «Available Subcases» указываем 

Default. Данное имя должно появиться в поле «Subcase Name». 

Для изменения параметров расчетного случая используем кнопку Subcase 

Parameters. 

В поле «Number of Load Increments» вводит число ступеней (или шагов) 

нагружения, например 25. OK. 

Для включения опции вывода промежуточных решений нажимаем кнопку 

Output Requests (запросы по выводу). В выпадающем меню «Form Type» 

(тип окна) выбираем пункт Advanced (расширенный) и устанавливаем «In-

termediate Output Option»: Yes (выводить результаты для каждого вычис-

ленного шага нагружения). OK. 

Последовательно нажимаем  Apply и Cancel. 

И, наконец, для запуска задачи на счет нажимаем кнопку Apply основной 

диалоговой панели приложения. 

Появляющиеся здесь сообщения закрываем кнопкой Yes. 
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18. Присоединить файл результатов расчета к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчета устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

lab2.xdb, OK. 

В заключение нажимаем Apply. 

19. Определить верхнюю критическую нагрузку. 

Запускаем приложение «Results». Для быстрого изображения результатов 

используем сочетание Create/Quick Plot. 

В данном случае для каждого шага по нагрузке создается отдельный слу-

чай результатов. Случаи результатов представлены в списке «Select Result 

Cases», где указываются текущие значения нагрузки в процентах от пол-

ной (рисунок 2.3). 

 

 
Рисунок 2.3 – Случаи результатов 

 

Можно заметить, что решение достигло лишь 55,5% заданной нагрузки. 

При превышении этого значения решение расходится, поскольку оболочка 

теряет устойчивость с перескоком. 

Таким образом, верхняя критическая нагрузка в
крP  для рассматриваемой 

конструкции составляет 4 0,555 2,22⋅ = кН, что почти в пять раз меньше 

критической нагрузки 0
крP , найденной методом начальной устойчивости. 

Таким образом, метод начальной устойчивости для решения подобных за-

дач не применим!!! 

20. Построить кривую равновесных состояний. 

Для построения двухмерного графика устанавливаем сочетание Create/ 

Graph/Y vs X. 
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В разделе «Select Result Cases» выбираем сразу все случаи результатов, 

соответствующие различным ступеням нагружения (кнопка     должна 

быть отжата). 

В списке «Select Y Results» в качестве выходной величины, отображаемой 

по оси ординат, выбираем Displacement, Translational (поступательные пе-

ремещения). Ниже в выпадающем меню «Quantity» указываем компоненту 

Magnitude (величина, т.е. длина вектора). 

В меню «X» за ось абсцисс принимаем Global Variable (глобальную пере-

менную). 

Ниже в меню «Variable» выбираем пункт Percent of Load, тем самым, 

уточняя, что в качестве глобальной переменной будет использоваться на-

грузка (с указанием значений в процентах от полной нагрузки). 

Для выбора целевых объектов с помощью кнопки-пиктограммы       меня-

ем вид диалоговой панели. 

Активизируем поле «Select Nodes» и в графическом окне указываем узел в 

центре цилиндрической панели. 

После нажатия кнопки  Apply в отдельном окне появляется график зави-

симости прогиба в центре оболочки от нагрузки (рисунок 2.4). 

 

Рисунок 2.4 – Зависимость перемещение – сила, получаемая при задании  
приращений нагрузки 

 

Отметим, что при задании приращений нагрузки нельзя построить полную 

кривую равновесных состояний, поскольку данный прием не позволяет 

проходить через предельные точки. В этих точках матрица тангенциаль-

ной жесткости сингулярная, и решение либо расходится (как в нашем слу-



 27

чае), либо происходит перескок на другую устойчивую ветвь кривой рав-

новесных состояний. 

Для удаления окна с графиком устанавливаем сочетание Delete/Plots и в 

списке «Existing Plot Types» выбираем GRA_default_Graph, Apply. 

 

III.  Геометрически нелинейный анализ (задание приращений  
       перемещений). 

21. Удалить нагрузку. 
Запускаем приложение «Loads/BCs» и устанавливаем сочетание Delete/ 

Force. 

В списке существующих наборов «Existing Sets» указываем load, Apply. 

22. Вместо силы приложить в центральной точке перемещение. 

Для задания перемещений выбираем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя вновь создаваемого набора, например 

load. 

Нажимаем кнопку Input Data и для задания смещения против оси Y в поле 

«Translations» вводим следующие компоненты вектора (в мм): <0,-30,0>, 

OK. 

Далее нажимаем кнопку Select Application Region. Для выбора геометриче-

ских объектов устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (точка или вершина) и указываем централь-

ную точку цилиндрической панели (Point 1, Curve 1.2 или Surface 1.3.1). 

Последовательно нажимаем кнопки Add, OK и  Apply. 

23. Выполнить геометрически нелинейный анализ. 

Запускаем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

С помощью кнопки Solution Type проверяем, выбрана ли опция Nonlinear 

Static (нелинейный статический анализ), OK. 

Затем для модификации расчетного случая нажимаем кнопку Subcases. 

В списке доступных расчетных случаев «Available Subcases» указываем 

Default. Данное имя должно появиться в поле «Subcase Name». 

Для изменения параметров расчетного случая используем кнопку Subcase 

Parameters. 
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В поле «Number of Load Increments» вводит число ступеней (или шагов) 

нагружения: 30, OK. 

С помощью кнопки Output Requests проверяем, установлена ли опция вы-

вода промежуточных решений. OK. 

Последовательно нажимаем  Apply и Cancel. 

И, наконец, для запуска задачи на счет нажимаем кнопку Apply основной 

диалоговой панели приложения. 

Появляющиеся здесь сообщения закрываем кнопкой Yes. 

24. Присоединить файл результатов расчета к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчета устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

lab2.xdb, OK. 

В заключение нажимаем Apply. 

25. Построить кривую равновесных состояний. 

Запускаем приложение «Results» и устанавливаем сочетание Create/ 

Graph/Y vs X. 

В разделе «Select Result Cases» выбираем сразу все случаи результатов, 

соответствующие различным ступеням нагружения. 

В списке «Select Y Results» в качестве выходной величины, отображаемой 

по оси ординат, выбираем Constraint Forces, Translational (силы реакций). 

Ниже в выпадающем меню «Quantity» указываем компоненту 

Y Component. 

В меню «X» за ось абсцисс принимаем Global Variable (глобальную пере-

менную). 

Ниже в меню «Variable» выбираем пункт Percent of Load. 

Для выбора целевых объектов с помощью кнопки-пиктограммы       меня-

ем вид диалоговой панели. 

Активизируем поле «Select Nodes» и в графическом окне указываем узел в 

центре цилиндрической панели. 

Далее с помощью кнопки-пиктограммы      устанавливаем вид для задания 

атрибутов изображения. 

В выпадающем меню «Curve Fit» (подгонка кривой) для сглаживания кри-

вой выбираем пункт Least Squares (метод наименьших квадратов). 
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И, наконец, для задания опций вычерчивания нажимаем кнопку-

пиктограмму      . 

В поле «Scalar Factor» (коэффициент масштабирования) вводим отрица-

тельное число: -0.004 (для получения значений силы для полной конст-

рукции в кН). 

Нажимаем  Apply. 

Отображаемый в этом случае график показан на рисунке 2.5. 

 

 

Рисунок 5 – Зависимость сила – перемещение, получаемая при задании  
приращений перемещений 

 

Отметим, что по оси абсцисс здесь откладываются значения перемещения 

в процентах от заданного (т.е. 100% соответствует перемещению в 30 мм), 

а по оси ординат – значения центральной силы P  (в кН). 

Для удаления окна с графиком устанавливаем сочетание Delete/Plots и в 

списке «Existing Plot Types» выбираем GRA_default_Graph, Apply. 

26. Определить верхнюю и нижнюю критические нагрузки. 

Для формирования текстового отчета устанавливаем сочетание Create/ 

Report/Append File. 

В разделе «Select Result Cases» выбираем сразу все случаи результатов, 

соответствующие различным ступеням нагружения. 

В списке «Select Report Result» указываем  Constraint Forces, Translational 

(силы реакций). 

В списке «Select Quantities» выбираем компоненту Y Component. 
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Для выбора целевых объектов с помощью кнопки-пиктограммы       меня-

ем вид диалоговой панели. 

В выпадающем меню «Target Entity» (целевые объекты) выбираем Nodes 

(узлы). 

Активизируем поле «Select Nodes» и в графическом окне указываем узел в 

центре цилиндрической панели. 

С помощью кнопки-пиктограммы       меняем вид диалоговой панели. 

В поле «File Name» вводим новое имя файла отчета, например Lab2.rpt. 

И, наконец, для задания опций вычерчивания нажимаем кнопку-

пиктограмму      . 

В поле «Scalar Factor» (коэффициент масштабирования) вводим значение 

-0.004. 

Нажимаем  Apply. 

Файл Lab2.rpt записывается в рабочую папку пользователя. Он будет со-

держать, в частности, следующие данные: 

% of Load    Y Component 

3.33333      0.385382 
6.66667      0.752572 
10.          1.087873 
13.3333      1.276289 
16.6667      1.544026 
20.          1.782592 
23.3333      1.993317 
26.6667      2.036274 
30.          2.177243 
33.3333      2.208565 
36.6667      2.279461 
40.          2.161691 
43.3333      2.090053 
46.6667      1.955874 
50.          1.784340 
53.3333      1.168436 
56.6667      0.842921 
60.          0.627947 
63.3333      0.467819 
66.6667      0.470183 
70.          0.527525 
73.3333      0.719951 
76.6667      0.852208 
80.          1.065348 
83.3333      1.420261 
86.6667      1.749240 
90.          2.081060 
93.3333      2.463956 
96.6667      3.022873 
100.         3.496700 

Анализ полученных данных показывает, что сила сначала возрастает до 

некоторого значения, которое характеризует верхнюю критическую на-
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грузку, затем убывает до значения, соответствующего нижней критиче-

ской нагрузке, после чего снова возрастает.  

Таким образом, для рассматриваемой конструкции в
крP =  2,28 кН  и  н

крP =  

0,47 кН. Здесь для верхней критической нагрузки получается более точное 

значение. 

Напомним, что данный прием имеет ряд существенных ограничений. Он 

применим лишь в случае действия сосредоточенной нагрузки и не позво-

ляет определять участки кривой равновесных состояний, не однозначные 

по перемещению. 

 

IV.  Использование метода длины дуги. 

27. Удалить заданное в центральной точке перемещение. 

Запускаем приложение «Loads/BCs» и устанавливаем сочетание Delete/ 

Displacement. 

В списке существующих наборов «Existing Sets» указываем load, Apply. 

28. Снова задать сосредоточенную силу в центре панели. 

В том же приложении выбираем сочетание Create/Force/Nodal. 

В поле «New Set Name» вводим имя нового набора, например load. 

Нажимаем кнопку Input Data и в поле «Force» для задания силы, дейст-

вующей в отрицательном направлении оси Y, вводим следующие компо-

ненты (в Н): <0 -1000 0>. OK. 

Далее нажимаем кнопку Select Application Region. Для выбора геометриче-

ских объектов устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку     (точка или вершина) и указываем точку в 

центре цилиндрической панели (Point 1, Curve 1.2 или Surface 1.3.1). 

Последовательно нажимаем кнопки Add, OK и  Apply. 

29. Выполнить геометрически нелинейный анализ с использованием метода 

длины дуги. 

Запускаем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

С помощью кнопки Solution Type проверяем, выбрана ли опция Nonlinear 

Static (нелинейный статический анализ), OK. 

Затем для модификации расчетного случая нажимаем кнопку Subcases. 
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В списке доступных расчетных случаев «Available Subcases» указываем 

Default. 

Для изменения параметров расчетного случая используем кнопку Subcase 

Parameters. 

В поле «Number of Load Increments» вводит число ступеней (или шагов) 

нагружения: 30, OK. 

Далее для включения метода длины дуги нажимаем кнопку Arc-Length 

Method и устанавливаем флаг «Use Arc-Length Method». 

В поле «Min. Adjust. ratio (MINALR)» (минимальный множитель) вводим 

значение 0.1, а в поле «Max. Adjust. ratio (MAXALR)» (максимальный 

множитель) – значение 4. 

Данные параметры используются для задания пределов изменения длины 

дуги от одного шага к другому, т.е. в случае хорошей сходимости длина 

дуги может за один шаг увеличиться максимум в четыре раза, а при пло-

хой – уменьшиться максимум в десять раз. 

В поле «Max. Controlled Increment Steps» (максимально допустимое число 

шагов приращений) вводим число 100. OK. 

С помощью кнопки Output Requests проверяем, установлена ли опция вы-

вода промежуточных решений. OK. 

Последовательно нажимаем  Apply и Cancel. 

И, наконец, для запуска задачи на счет нажимаем кнопку Apply основной 

диалоговой панели приложения. 

Появляющиеся здесь сообщения закрываем кнопкой Yes. 

30. Присоединить файл результатов расчета к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчета устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

lab2.xdb, OK. 

В заключение нажимаем Apply. 

31. Построить кривую равновесных состояний. 

Запускаем приложение «Results» и устанавливаем сочетание Create/Graph/ 

Y vs X. 

В разделе «Select Result Cases» выбираем сразу все случаи результатов, 

соответствующие различным ступеням нагружения. 
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В списке «Select Y Results» в качестве выходной величины, отображаемой 

по оси ординат, выбираем Displacement, Translational (поступательные пе-

ремещения). Ниже в выпадающем меню «Quantity» указываем компоненту 

Magnitude. 

В меню «X» за ось абсцисс принимаем Global Variable. Ниже в меню 

«Variable» выбираем пункт Percent of Load. 

Для выбора целевых объектов с помощью кнопки-пиктограммы       меня-

ем вид диалоговой панели. 

Активизируем поле «Select Nodes» и в графическом окне указываем узел в 

центре цилиндрической панели. 

Далее с помощью кнопки-пиктограммы      устанавливаем вид для задания 

атрибутов изображения. 

В выпадающем меню «Curve Fit» для сглаживания кривой выбираем 

пункт Spline (сплайн). 

Снимаем флаг «Sort Data By X Coordinate» (сортировать данные по X ко-

ординате). 

И, наконец, для задания опций вычерчивания нажимаем кнопку-

пиктограмму      . 

В поле «Scalar Factor» (коэффициент масштабирования) вводим число 1. 

Нажимаем  Apply. В отдельном окне появляется график (рисунок 2.6). 

 

 

Рисунок 2.6 – Зависимость перемещение – сила, получаемая методом  
длины дуги 
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Отметим, что по оси абсцисс здесь откладываются значения силы в про-

центах от заданной (т.е. 100% соответствует силе в 4 кН), а по оси ординат 

– значения прогиба в центральной точке (в мм). 

32. Выйти из программы: File>Quit. 

 

 

 

Дополнительное задание: найти верхнюю и 

нижнюю критические силы для цилиндрической пане-

ли, представленной на рисунке 2.1, но с толщиной  

h =  6,3 мм. Кривую равновесных состояний записать в 

файл  Lab2.png, применяя команду File>Images полосы 

меню. При этом использовать установки, как показано 

на рисунке справа. 
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3 ИССЛЕДОВАНИЕ  ЗАКРИТИЧЕСКОГО  ДЕФОРМИРОВАНИЯ  
ПОЛОГОЙ  СФЕРИЧЕСКОЙ  ОБОЛОЧКИ ПРИ  ПОМОЩИ  
CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: шарнирно опёртая по контуру пологая сферическая 

оболочка нагружена в вершине сосредоточенной силой P  (рисунок 3.1). Ма-

териал линейно-упругий изотропный ( 46,895 10E = ⋅ МПа; 0,3µ = ). 

Допущение: учитываются только осесимметричные формы потери ус-

тойчивости. 

Цель: исследовать закритическое поведение конструкции методом дли-

ны дуги; построить зависимость сосредоточенной силы P  от прогиба в цен-

тре w. 

 
Рисунок 3.1 – Геометрия сферической оболочки 

 

Рекомендации:  

1. Для построения модели использовать элементы осесимметричной 

оболочки SHELL208. 

2. Оболочку разбить на 25 конечных элементов. 

3. Силу P  принять равной 250 Н. 

4. При задании опций анализа выбрать статический анализ с учётом 

больших перемещений (Large Displacement Static) и активизировать метод 

длины дуги (Activate arc-length method), при этом принять: 

«Number of substep» = 100; 

«Max multiplier» = 4; 

«Min multiplie» = 0.002. 

5. При построении графика ( )P f w=  прогиб считать положительным. 

График записать в файл Lab3.png. 

P  

θ  θ  

o10,9θ =  
120,9R = мм 

0,4h = мм 
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4 ИССЛЕДОВАНИЕ  НЕСУЩЕЙ  СПОСОБНОСТИ  
ПРОРЫВНОЙ  МЕМБРАНЫ  ПРИ  ПОМОЩИ   
CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: круглая в плане мембрана, имеющая кольцевую ост-

рую насечку (рисунок 4.1), нагружена распределенным по нижней поверхно-

сти давлением p . Размеры данной конструкции представлены на рисун-

ке 4.2. Юбка мембраны вставляется в жесткую оправку. Материал – техниче-

ски чистый алюминий АД0 (модуль упругости 7·104 МПа; коэффициент Пу-

ассона 0,3), условная диаграмма деформирования которого задана точками 

(таблица 4.1). 

Допущения: поскольку конструкция мембраны и нагрузка симметрич-

ны относительно одной оси, можно рассматривать лишь одно сечение и све-

сти трехмерную задачу в двухмерной осесимметричной. Диаграмма дефор-

мирования материала аппроксимируется кусочно-линейной зависимостью. 

Цель: определить по расходимости итераций критическое значение 

давления, при котором происходит разрушение мембраны. 

 

 
Рисунок 4.1 – Общий вид прорывной мембраны 

 

 
Рисунок 4.2 – Размеры мембраны 
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Таблица 4.1 – Зависимость условного напряжения от деформации 

№ ε  σ , МПа 

1 0,000554 38,8 

2 0,01 49,9 
3 0,04 60,0 
4 0,10 69,3 

5 0,20 75,6 
6 0,30 78,1 

7 0,40 79,0 
8 0,50 78,6 

9 0,55 77,4 
 

Поскольку технически чистый алюминий обладает высокой пластично-

стью, в данной задаче ожидаются большие деформации. Поэтому здесь по-

требуется действительная диаграмма деформирования, выражающая зависи-

мость действительного напряжения σ  от логарифмической деформации ε . 

Для их вычисления воспользуемся следующими формулами: 

(1 )σ σ ε= + ;       ln(1 )ε ε= + . 

Рассчитанные таким образом значения сведены в таблицу 4.2. Следует 

отметить, что отношение координат первой точки 1 1σ ε  должно быть равно 

модулю упругости, поэтому после пересчета их значения оставлены без из-

менения. В противном случае при запуске задачи на счет ANSYS выдаст со-

общение об ошибке. 

 

Таблица 4.2 – Зависимость действительного напряжения 
                                 от логарифмической деформации 

№ ε  σ , МПа 
1 0,000554 38,8 

2 0,00954 50,4 

3 0,0389 62,5 

4 0,0956 76,3 

5 0,1827 90,8 

6 0,2628 101,6 

7 0,3369 110,7 

8 0,4055 117,9 

9 0,4362 119,8 
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Для сравнения на рисунке 4.4 представлены условная (штриховая ли-

ния) и действительная (сплошная линия) диаграммы деформирования рас-

сматриваемого материала. 

 

0

20

40

60

80

100

120

0 0,1 0,2 0,3 0,4 0,5 0,6
ε
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Рисунок 4.4 – Диаграммы деформирования материала АД0 

 

Следует напомнить, что при решении осесимметричных задач в про-

грамме ANSYS глобальная ось Y должна являться осью симметрии, а  X – ра-

диальной осью. Начало системы координат сечения поместим в верхнюю 

точку мембраны, причем ось  X направим вправо, а ось Y – вверх, как показа-

но на рисунке 4.5. 

 

 

 
Рисунок°4.5 – Расчетная схема 

 

Для решения задачи предлагается выполнить следующие действия. 
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1. Запустить пакет ANSYS, указать имя задачи Lab4. 

2. Установить тип используемых в расчете конечных элементов – 8-узловой 

плоский элемент PLANE183 с формулировкой «осесимметричное поведе-

ние»: M_M>Preprocessor>Element Type>Add/Edit/Delete. 

Нажимаем Add и выбираем  Structural Solid>Quad 8node 183, OK. 

В окне «Element types» нажимаем Options и для опции K3 устанавливаем 

значение Axisymmetric. Далее OK и Close. 

3. Задать свойства материала: M_M>Preprocessor>Material Props>Material 

Models. 

Сначала задаем линейные упругие свойства. Для этого в правом окне по-

следовательно выбираем  Structural>Linear> Elastic>Isotropic. 

Вводим: 

EX: 7e4 (модуль упругости, МПа) 

PRXY: 0.3 (коэффициент Пуассона) 

OK. 

Далее определяем нелинейный участок диаграммы деформирования, вы-

бирая полилинейную модель с изотропным упрочнением: Structural>  

Nonlinear>Inelastic>Rate independent>Isotropic Hardening Plasticity>Mises 

Plasticity>Multilinear. 

При этом появляется диалоговая панель, где по умолчанию установлен 

режим ввода значений напряжения в зависимости от полной деформации 

(Stress versus Total Strain). 

В столбцы «STRAIN» и «STRESS» вводим соответственно значения лога-

рифмической деформации и действительного напряжения из таблицы 4.2. 

Для добавления новой строки (т.е. точки) здесь следует воспользоваться 

кнопкой Add Point. 

По окончании для проверки введенных значений следует отобразить зави-

симость σ ε−  в виде графика (кнопка Graph). 

Завершаем процесс ввода кнопкой OK и закрываем панель. 

4. Построить геометрическую модель сечения мембраны.  

Как видно из рисунка 4.2, настоящая модель может быть получена путем 

комбинирования нескольких примитивов (сектора узкого кольца и двух 

прямоугольников) с последующим скруглением углов. 

4.1. Построить сектор кольца: M_M>Preprocessor>Modeling>Create>  

Areas>Circle>Partial Annulus. 
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Вводим следующие параметры: координаты центра кольца WP X = 0 

и WP Y = -60; внешний радиус Rad-1 = 60; начальный угол сектора 

Theta-1 = 70; внутренний радиус Rad-2 = 59; конечный угол сектора 

Theta-2 = 90. Нажимаем  OK. 

4.2. Построить два прямоугольника: M_M>Preprocessor>Modeling>  

Create>Areas>Rectangle>By 2 Corners. 

Для первого прямоугольника вводим следующие параметры: коорди-

наты левого верхнего угла WP X = 21.5 и WP Y = 0; ширина 

Width = 1; высота Height = -4. Нажимаем кнопку Apply для продол-

жения данной операции. 

Для второго прямоугольника задаем: координаты правого нижнего 

угла WP X = 22.5 и WP Y = -4; Width = -5; Height = 1. Нажимаем OK 

для завершения этой операции. 

Включим нумерацию поверхностей: U_M>PlotCtrls>Numbering. От-

мечаем флаг «Area numbers». 

Появляющееся при этом изображение показано на рисунке 4.6. 

 
Рисунок 4.6 – Поверхности с нумерацией 

 

4.3. Выполнить булеву операцию перекрытия двух ближайших к оси вра-

щения поверхностей: M_M>Preprocessor>Modeling>Operate> 

Booleans>Overlap>Areas. 

Указываем поверхности A1 и A3, OK. 

4.4. Удалить лишние поверхности: M_M>Preprocessor>Modeling>Delete> 

Areas and Below. 

Указываем две расположенные внизу треугольные поверхности (A4 и 

A5), OK. 

4.5. С помощью булевой операции сложения объединить все поверхности 

в одну: M_M>Preprocessor>Modeling>Operate>Booleans>Add> 

Areas. 
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Кнопкой Pick All указываем все поверхности. 

4.6. Удалить только поверхность, оставляя ограничивающие ее линии: 

M_M>Preprocessor>Modeling>Delete>Areas Only. 

Указываем поверхность, OK. 

Для отображения линий выбираем последовательность: U_M>Plot> 

Lines. 

Включим их нумерацию: U_M>PlotCtrls>Numbering. Отмечаем флаг 

«Line numbers» (рисунок 4.7). 

 

 
Рисунок 4.7 – Линии с нумерацией 

 

4.7. Объединить линии, образующие стороны сечения мембраны: M_M> 

Preprocessor>Modeling>Operate>Booleans>Add>Lines. 

Сначала указываем линии L20 и L18, OK. При этом появляется до-

полнительное окно, где по умолчанию установлена опция удаления 

исходных линий. Ничего не меняя, закрываем его кнопкой Apply. 

Затем аналогичным образом объединяем три линии L15, L1 и L5. 

В заключение объединяем линии L3 и L4. 

4.8. Выполнить скругление углов: M_M>Preprocessor>Modeling>Create> 

Lines>Line Fillet. 

Указываем мышью в рабочем окне две линии L18 и L1, OK. 

В поле «Fillet radius» вводим число 11 (радиус скругления в мм). На-

жимаем кнопку Apply для продолжения данной операции. 

Аналогично строим скругления радиусом 10 мм между линиями L19 

и L11, радиусом 1,5 мм между линиями L1 и L3, радиусом 0,5 мм 

между линиями L11 и L9. 

4.9. Построить поверхность по линиям, образующим ее контур: 

M_M>Preprocessor>Modeling>Create>Areas>Arbitrary>By Lines. 
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Последовательно указываем линии, обходя контур, например, против 

хода часовой стрелки: L2, L18, L4, L1, L6, L3, L7, L9, L8, L11, L5 и 

L19 (всего двенадцать линий). 

Для отображения поверхности выбираем последовательность: 

U_M>Plot>Areas. 

4.10. Для моделирования насечки построить равносторонний треугольник: 

M_M>Preprocessor>Modeling>Create>Areas>Polygon>Triangle. 

Вводим следующие параметры: координаты цента тяжести треуголь-

ника WP X = 19 и WP Y = -3; радиус описанной окружности Ra-

dius = 0.5; угол поворота Theta = 30. 

OK. 

4.11. Сделать насечку при помощи булевой операции вычитания поверх-

ностей: M_M>Preprocessor>Modeling>Operate>Boolean>Subtract> 

Areas. 

На первый запрос указываем поверхность A1 (моделирующую сече-

ние мембраны), OK. 

На второй запрос указываем поверхность A2 (треугольник), OK. 

В результате геометрическая модель будет представлена поверхно-

стью A3 сложной формы, полностью соответствующей расчетной 

схеме (см. рисунок 4.5). 

5. Выделить двумя сечениями область насечки для построения в ней более 

мелкой сетки. 

5.1. Сместить начало рабочей плоскости в вершину насечки: 

U_M>WorkPlane>Offset WP to>Keypoints. 

Указываем мышью точку в вершине насечки, OK. 

5.2. Повернуть рабочую плоскость на 90° вокруг оси WY: U_M>  

WorkPlane>Offset WP by increments. 

Вводим: 

 «XY,YZ,ZX Angles»: 0,0,90 

Apply. 

5.3. Сместить рабочую плоскость на 0,5 мм в отрицательном направлении 

оси WZ. 

В диалоговой панели «Offset WP» вводим: 

 «X,Y,Z offsets»: 0,0,-0.5 

Apply. 
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5.4. Разрезать все поверхности рабочей плоскостью: M_M>Preprocessor> 

Modeling>Operate>Booleans>Divide>Area by WrkPlane. 

Нажимаем Pick All. 

5.5. Сместить рабочую плоскость на 1 мм в положительном направлении 

оси WZ. 

В диалоговой панели «Offset WP» вводим: 

 «X,Y,Z offsets»: 0,0,1 

Apply. 

5.6. Разрезать все поверхности рабочей плоскостью: M_M>Preprocessor> 

Modeling>Operate>Booleans>Divide>Area by WrkPlane. 

Нажимаем Pick All. 

6. Разбить поверхности на конечные элементы: M_M>Preprocessor> 

Meshing>MeshTool. 

Для определения размера элементов на поверхностях в разделе «Size Con-

trols» нажимаем кнопку Set строки «Areas». Указываем все поверхности 

кнопкой Pick All и в поле «Element edge length» (длина стороны элемента) 

вводим значение 0.3 (в мм). Apply. 

Для сгущения сетки указываем область насечки, OK. В поле «Element edge 

length» вводим меньшее значение, например 0.1, OK. 

Далее воспользуемся кнопкой Set строки «Lines». Указываем дугу скруг-

ления радиусом 0.5 мм, нажимаем OK и в поле «Element edge length» вво-

дим значение 0.1, OK. 

Затем в списке «Mesh» в качестве объектов для разбиения выбираем Areas 

(поверхности), в поле «Shape» (форма элементов) указываем Quad (четы-

рехугольная). 

Устанавливаем режим Free (свободная сетка). 

Для включения интеллектуальных средств построения сеток активизируем 

опцию «Smart Size». При помощи «бегунка» задаем первый уровень раз-

бивки (Fine). 

Для генерации сетки нажимаем кнопку Mesh и указываем все поверхности 

(Pick All). 

7. Задать граничные условия. 
Напомним, что при решении осесимметричной задачи в программе AN-

SYS все узлы, расположенные на оси симметрии Y, должны быть закреп-

лены от перемещения в радиальном направлении. 
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Кроме того, на рассматриваемую мембрану наложены связи по контуру 

юбки (см. рисунок 4.5). 

Воспользуемся командой задания перемещений на линиях: 

M_M>Solution>Define Loads>Apply>Structural>Displacement>On Lines. 

Указываем одну вертикальную линию слева (лежащую на оси симметрии) 

и две вертикальные линии справа (представляющие контур юбки), OK. 

В списке «DOFs to be constrained» выбираем UX (запрет поступательных 

перемещений по оси X), Apply. 

Затем указываем верхнюю горизонтальную линию контура юбки, OK. 

В списке «DOFs to be constrained» выбираем UY (запрет поступательных 

перемещений по оси Y) и нажимаем OK. 

8. Задать давление: M_M>Solution>Define Loads>Apply>Structural> 

Pressure>On Lines. 

Указываем линии (всего пять) в нижней части контура сечения, OK. 

В поле «Load PRES value» вводим значение давления, заведомо превы-

шающее критическое, например 4 МПа. OK. 

На рисунке 4.8 показана конечно-элементная модель мембраны с задан-

ными граничными условиями и нагрузкой. 

 

 
Рисунок 4.8 – Конечно-элементная модель с граничными условиями  

и нагрузкой 
 

9. Выполнить геометрически и физически нелинейный анализ. 

Сначала меняем опции анализа: M_M>Solution>Analysis Type>Sol’n  

Controls. 

Выбираем вкладку «Basic». 

Для учета больших перемещений (и деформаций) в списке «Analysis Op-

tions» выбираем значение Large Displacement Static. 

Время в конце шага нагружения (поле «Time at end of loadstep» раздела 

«Time Control») задаем равным 1. 
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Таким образом, время t  будет меняться в интервале от 0 до 1 и давление в 

момент времени t  будет определяться равенством 
t p p t= ⋅ , 

где p  – заданное давление (в нашем случае 4 МПа). 

В списке «Automatic time stepping» (автоматический выбор шага по вре-

мени) оставляем значение по умолчанию: Prog Chosen (выбирается про-

граммой). При этом в случае плохой сходимости программа ANSYS будет 

автоматически уменьшать приращение нагрузки, что позволяет более точ-

но оценить несущую способность конструкции. При хорошей сходимости 

размер шага по времени будет увеличиваться. 

В поле «Number of substeps» (число подшагов) раздела «Time Control» вво-

дим 200. Учитывая установку предыдущей опции, данное значение не бу-

дет соответствовать реальному числу подшагов. Однако оно точно будет 

определять размер первого шага по времени: 1 1 200 0,005t∆ = = с. 

И, наконец, для сохранения промежуточных результатов на всех подшагах 

в списке «Frequency» (частота записи выходных величин в файл результа-

тов) выбираем значение Write every substep. 

После задания опций нелинейного анализа задача посылается на счет: 

M_M>Solution>Solve>Current LS. 

10. Оценить несущую способность прорывной мембраны: M_M>General 

Postproc>Result Summary. 

При этом на экране появляется список наборов результатов: 

  SET   TIME/FREQ    LOAD STEP   SUBSTEP  CUMULATIVE 
     1 0.50000E-02         1         1         1 
     2 0.10000E-01         1         2         2 

    -------------------------------------------- 

    43 0.77707             1        43       184 
    44 0.77736             1        44       196 
    45 0.77750             1        45       205 
    46 0.77755             1        46       210 
    47 0.77760             1        47       222 
    48  1.0000             1    999999       225 

Здесь в первом столбце указывается номер набора результатов, во втором 

– текущее время, в третьем – номер шага по нагрузке, в четвертом – номер 

подшага и в пятом – общее (к данному моменту времени) число итераций. 

Последний подшаг здесь имеет максимально возможный номер 999999. 

Это говорит о том, что последний набор результатов содержит несошед-

шееся (т.е. физически недостоверное) решение. 
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Таким образом, несущую способность (или критическую нагрузку) можно 

оценить по времени предпоследнего подшага: 

кр 0,7776 3,11p p= = МПа. 

11. Изобразить поле напряжений по Мизесу на предпоследнем подшаге. 

Сначала следует считать из файла результатов в базу данных предпослед-

ний набор: M_M>General Postproc>Read Results>By Pick. 

Указываем предпоследний набор результатов и нажимаем Read, а затем 

Close. 

Далее используем команду M_M>General Postproc>Plot Results>Contour 

Plot>Nodal Solu. 

Из списка доступных результатов выбираем Nodal Solution>Stress>von 

Mises stress (напряжение по Мизесу), OK. 

Получаемое при этом изображение представлено на рисунке 4.9. 

 

 
Рисунок 4.9 – Поле напряжений по Мизесу (МПа) 

 

12. Включить анимацию процесса деформирования во времени: U_M> 

PlotCtrls>Animate>Over Time (данная команда выполнима только в моду-

ле общего постпроцессора). 

В поле «Number of animation frames» (число кадров анимации) вводим зна-

чение 30 для получения более плавной анимации. 

Активизируем опцию «Time Range» (временной диапазон) и ниже вводим 

границы диапазона: 0; 0.7776. 
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В списке «Contour data for animation» выбираем выходную величину для 

изображения ее поля в процессе анимации (например, напряжение по Ми-

зесу). 

Остальные параметры оставляем без изменения. 

Нажимаем OK. 

Некоторое время займет формирование видео файла, после чего в рабочем 

окне будет представлена анимация переходного динамического процесса. 

Кроме того, появится дополнительная панель «Animation Controller», где 

следует включить опцию «Forward Only» (только вперед). 

«Бегунок» данной панели позволяет управлять задержкой между кадрами 

(т.е. увеличивать или уменьшать скорость анимации). 

Нажав Stop и Close, можно остановить анимацию и закрыть диалоговую 

панель «Animation Controller». 

13. Построить зависимость пластической деформации в вершине насечки от 

времени: M_M>TimeHist Postpro. 

Для задания новой переменной в диалоговой панели постпроцессора ис-

тории нагружения нажимаем кнопку Add Data. 

При этом появляется дополнительное окно, где в списке выходных вели-

чин «Result Item» последовательно указываем Nodal Solution>Plastic 

Strain>von Mises plastic strain (эквивалентная пластическая деформация по 

Мизесу). 

В поле «Variable Name» (имя переменной) вводим epl. OK. 

Далее на экране при помощи мыши указываем узел в вершине насечки. 

OK. 

Затем в списке выделяем переменную epl и нажимаем кнопку Graph Data. 

Отображаемый при этом график представлен на рисунке 4.10. 

14. Для отчета по работе записать в файл протокол команд базы данных: 

U_M>File>Write DB Log File. 

Вводим имя Lab4.lgw. 

15. Выйти из программы: ANSYS Toolbar>QUIT. 
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Рисунок 4.10 – Зависимость пластической деформации от времени 
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5 РЕШЕНИЕ  ЗАДАЧИ  О  РАСТЯЖЕНИИ  ПОЛОСЫ,  
ОСЛАБЛЕННОЙ  УГЛОВЫМ  ВЫРЕЗОМ,  
ПРИ ПОМОЩИ  CAE-СИСТЕМЫ  MSC.PATRAN/NASTRAN 

 

Исходные данные: полоса с угловым вырезом равномерно растягивает-

ся напряжениями 0 1000σ = МПа (рисунок 5.1). Вершина выреза притуплена 

радиусом R0,5. Материал – сталь 30ХГСА (модуль упругости 52 10E = ⋅ МПа; 

коэффициент Пуассона 0,3µ = ; предел пропорциональности пц 860σ = МПа; 

условный предел текучести 0,2 970σ = МПа), диаграмма деформирования ко-

торого задана точками (таблица 5.1). 

Допущение: предполагается, что реализуется плоская деформация. 

Цель: исследовать развитие пластических деформаций вблизи вершины 

выреза по мере возрастания нагрузки. 
 

 
Рисунок 5.1 – Геометрия полосы с вырезом 

 

Таблица 5.1 – Зависимость напряжения от деформации 

№ ε  σ , МПа 

1 0 0 

2 0,0043 860 

3 0,0050 920 

4 0,0069 970 

5 0,010 1010 

6 0,015 1045 

7 0,020 1067 

8 0,025 1085 

9 0,030 1095 

10 0,035 1100 

11 0,040 1100 

60° 

6 
100 

20
 

x  

y  

0σ  0σ  
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Диаграмма деформирования стали 30ХГСА, построенная с использова-

нием данных таблицы 5.1, представлена на рисунке 5.2. Следует отметить, 

что при задании кривой σ ε−  для решателя MSC.Nastran первая точка долж-

на иметь нулевые координаты ( 1 0σ = , 1 0ε = ), а вторая точка – определять 

предел текучести ( т 2σ σ= ). При этом наклон линии, соединяющей первую и 

вторую точки, должен быть равен модулю упругости: 

2

2

E
σ
ε

= . 

 

 
Рисунок 5.2 – Диаграмма деформирования стали 

 

Подчеркнем, что в МКЭ-пакетах не различаются понятия пределов 

пропорциональности, упругости и текучести. 

Вне области определения данной кривой ее экстраполяция осуществля-

ется с сохранением наклона концевого сегмента, поэтому в конце добавлен 

горизонтальный участок. 

Благодаря симметрии конструкции и нагрузки относительно верти-

кальной оси здесь можно ограничиться рассмотрением половины полосы. 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить пакет MSC.Patran и открыть новую базу данных. 

,σ  
МПа 

ε  
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В полосе меню выбираем команду File>New. 

В поле «File name» указываем имя файла базы данных Lab5.db, OK. 

2. Задать начальные установки. 

В разделе «Tolerance» выбираем опцию «Based on Model» (на основе мо-

дели) и в поле «Model Dimension» (габаритный размер модели) вводим 

значение 50 (в мм), OK. 

3. Построить два прямоугольника. 
Выбираем приложение «Geometry» и устанавливаем сочетание Create/ 

Surface/XYZ. 

Для первого прямоугольника вводим: 

 «Vector Coordinates List»: <6 20 0> (описывающий диагональ вектор) 

 «Origin Coordinate List»: [0 0 0] (координаты начала вектора) 

Apply. 

Для второго прямоугольника: 

 «Vector Coordinates List»: <44 20 0> 

 «Origin Coordinate List»: [6 0 0] 

Apply. 

Для визуализации внутренней геометрии поверхностей воспользуемся 

кнопкой       панели инструментов. 

Включаем нумерацию геометрических объектов. 

4. Для определения выреза построить две точки. 

Сначала полезно с помощью кнопки     панели инструментов увеличить 

размер изображения точек до девяти пикселей. 

Устанавливаем сочетание Create/Point/XYZ. 

Для первой точки в поле «Point Coordinate List» вводим следующие значе-

ния координат (в мм): [3,0,0], Apply. 

Вторая точка по оси Y имеет значение координаты 3 3мм. Отметим, что в 

программе MSC.Patran при вводе отдельных компонент допустимы мате-

матические операции. Для этих целей используется обратный апостроф 

(располагается на одной клавише с буквой ё). 

Таким образом, для второй точки в поле «Point Coordinate List» вводим [0, 

`3*SQRT(3)`,0], Apply. 

5. Соединить построенные на предыдущем шаге точки прямой линией. 

Выбираем сочетание Create/Curve/Point. 

Используем установленную по умолчанию опцию 2 Point. 
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Для поля «Starting Point List» указываем точку 7, а для поля «Ending Point 

List» – точку 8. 

Если снят флаг «Auto Execute», то для завершения операции нажимаем 

кнопку Apply. 

6. Создать зеркальное отображение проведенной на предыдущем шаге ли-

нии. 

Устанавливаем сочетание Transform/Curve/Mirror. 

В поле «Define Mirror Plane Normal» в качестве нормали к плоскости зер-

кала вводим Coord 0.1 (т.е. ось X). 

Проверяем, что флаг «Delete Original Curves» снят. 

Для поля «Curve List» указываем линию 1. 

При необходимости нажимаем Apply. 

7. Построить дугу скругления в вершине выреза. 
Устанавливаем сочетание Create/Curve/Fillet. 

В поле «Fillet Radius» вводим радиус скругления (в мм): 0.5. 

Опция «Trim Original Curves» (подрезать исходные кривые) должна быть 

включена. 

Для поля «Curve/Point 1 List» без использования клавиши Shift указываем 

кривую 1 и ее концевую точку со стороны оставляемой части (т.е. точ-

ку 7). 

Аналогично для поля «Curve/Point 2 List» указываем кривую 2 и точку 9. 

Если требуется, нажимаем Apply. 

8. Разбить дугу скругления на две части в месте ее пересечения с кромкой 

поверхности. 

Выбираем сочетание Edit/Curve/Break. 

Используем установленную по умолчанию опцию Point (разбиение при 

помощи точки). 

Для удаления исходной кривой включаем флаг «Delete Original Curves». 

Для поля «Curve List» указываем дугу скругления (Curve 3). 

Затем активизируем область ввода «Break Point List», в пиктографическом 

меню выбора нажимаем кнопку       (точка пересечения двух кривых) и без 

использования клавиши Shift указываем дугу скругления и левую кромку 

поверхности 1. 

При необходимости нажимаем Apply. 

Кнопкой Yes подтверждаем удаление исходной кривой. 

9. Добавить кромку поверхности. 
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Устанавливаем сочетание Edit/Surface/Edge. 

Ниже нажимаем среднюю кнопку-пиктограмму Add Edge (добавить кром-

ку). 

Используем опцию «Retain Long Portion of Edges» (оставить бóльшую 

часть периметра). 

Для поля «Surface» указываем поверхность 1, а для поля «Curve List» – 

лежащие на ней кривые 1 и 4. 

Если требуется, нажимаем Apply. 

10. Построить полуокружность. 
Устанавливаем сочетание Create/Curve/2D ArcAngles. 

В соответствующие поля вводим: 

 «Radius»: 2 (радиус, мм) 

 «Start Angle»: -90 (начальный угол, град) 

 «End Angle»: 90 (конечный угол, град) 

 «Construction Plane List»: Coord 0.3 (плоскость построения перпендику-

лярна оси Z глобальной декартовой системы координат). 

Активизируем поле «Center Point List» (центр дуги окружности) и указы-

ваем точку в вершине выреза (расположенную в середине дуги скругле-

ния). 

При необходимости нажимаем Apply. 

11. При помощи построенной на предыдущем шаге полуокружности разбить 

поверхность на две части. 

Выбираем сочетание Edit/Surface/Break. 

Используем установленную по умолчанию опцию Curve (разбиение при 

помощи кривой). 

Для удаления исходной поверхности включаем флаг «Delete Original Sur-

faces». 

Для поля «Surface List» указываем поверхность 1, а для поля «Break Curve 

List» – построенную на предыдущем шаге полуокружность. 

При необходимости нажимаем Apply. 

Кнопкой Yes подтверждаем удаление исходной поверхности. 

12. Удалить лишние кривые. 
Устанавливаем сочетание Delete/Curve. 

Активизируем поле «Curve List» и в графическом окне, удерживая нажа-

той левую кнопку мыши, охватываем прямоугольником всю модель. 

Если требуется, нажимаем Apply. 
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Геометрическая модель половины полосы с вырезом, состоящая из трех 

поверхностей, показана на рисунке 5.3. Напомним, что зеленым цветом 

изображаются простые поверхности, а пурпурным – сложные trimmed-

поверхности. 

 

 
Рисунок 5.3 – Поверхности с нумерацией 

 

13. Разбить поверхности на конечные элементы. 

Запускаем приложение «Elements» и устанавливаем сочетание Create/ 

Mesh/Surface. 

Выбираем: 

 «Elem Shape»: Quad (четырехугольная форма) 

 «Mesher»: Paver (генератор свободных сложных сеток) 

 «Topology»: Quad4 (топология – четырехугольник с четырьмя узлами). 

Активизируем поле «Surface List» и в графическом окне указываем по-

верхность, окружающую вершину выреза (Surface 3). 

В разделе «Global Edge Length» отключаем опцию автоматического вы-

числения глобальной длины стороны элемента и в поле «Value» вводим 

значение 0.2 (в мм). Apply. 

Затем для поля «Surface List» указываем прямоугольную поверхность 

(Surface 2) и в области «Value» вводим значение 1 (в мм). Apply. 

В конце указываем trimmed-поверхность (Surface 4) и для глобальной 

длины стороны элемента вводим значение 0.5 (в мм). Apply. 

14. Сшить конечно-элементную модель. 

Устанавливаем сочетание Equivalence/All/Tolerance Cube. 

Ничего не меняя, нажимаем Apply. При этом места сшивки модели обво-

дятся кружочками. 

Получаемая здесь разбивка показана на рисунке 5.4. 
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Рисунок 5.4 – Конечно-элементная сетка 

 

15. Построить поле свойств материала, описывающее диаграмму деформиро-
вания. 

Запускаем приложение «Fields» и устанавливаем сочетание Create/Material 

Property/Tabular Input. 

В области ввода «Field Name» вводим имя поля свойств материала, на-

пример diagram. 

В списке активных независимых переменных «Active Independent Vari-

ables» снимаем флаг «Temperature (T)» (температура) и устанавливаем 

флаг «Strain (e)» (деформация). 

Для ввода данных нажимаем кнопку Input Data. 

При этом появляется дополнительное окно с таблицей, содержащей два 

столбца (рисунок 5.5). Для ввода значения здесь необходимо активизиро-

вать соответствующую ячейку таблицы, набрать в поле «Input Data» нуж-

ное число и нажать клавишу Enter. 

 

 
Рисунок 5.5 – Табличное задание поля 
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Последовательно вводим 11 точек диаграммы из таблицы 5.1. 

Закрываем дополнительное окно кнопкой OK. 

В конце нажимаем Apply. 

Для проверки правильности задания поля отобразим его в виде двухмер-

ного графика (действие Show). 

В списке «Select Field To Show» выделяем строку diagram. 

Нажимаем Specify Range (задать диапазон) и в соответствующие поля вво-

дим: 

 «Minimum»: 0 (минимальное значение переменной e) 

 «Maximum»: 0.04 (максимальное значение переменной e) 

 «No. of Points»: 20 (число точек) 

OK. 

После нажатия Apply в отдельном окне появляется график, а рядом – таб-

лица значений. Закрываем ее кнопкой Cancel. 

Для закрытия окна с графиком следует воспользоваться кнопкой Unpost 

Current  XYWindow. 

16. Задать свойства материала. 
Запускаем приложение «Materials» и устанавливаем сочетание Create/  

Isotropic/Manual Input. 

В поле «Material Name» вводим имя материала, например steel. 

Далее нажимаем кнопку Input Properties (ввод свойств). При этом появля-

ется дополнительное окно, где по умолчанию установлена линейно-

упругая модель состояния (Linear Elastic). 

В соответствующие поля вводим: 

 «Elastic Modulus» = 2e5 (модуль упругости в МПа) 

 «Poisson Ratio» = 0.3 (коэффициент Пуассона) 

OK. 

Нажимаем кнопку Apply. При этом вновь созданная модель материала 

должна появиться в списке существующих материалов «Existing 

Materials». 

Для задания пластических свойств снова нажимаем Input Properties. 

В выпадающих меню выбираем: 

 «Constitutive Model»: Elastoplastic (упругопластическая модель состоя-

ния) 

 «Nonlinear Data Input»: Stress/Strain Curve (ввод кривой σ ε− ) 

 «Yield Function»: Von Mises (функция текучести Мизеса) 
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 «Hardening Rule»: Isotropic (изотропное упрочнение). 

Активизируем область ввода «Stress/Strain Curve =» и ниже в списке 

имеющихся полей свойств материалов выбираем diagram. OK. 

В конце опять нажимаем кнопку Apply. 

17. Определить свойства элементов. 
Выбираем приложение «Properties». Для задания свойств плоских элемен-

тов устанавливаем сочетание Create/2D/2D Solid. 

В поле «Property Set Name» вводим имя набора свойств, например band. 

Установленные по умолчанию опции Plane Strain (плоская деформация) и 

Standard Formulation (стандартная формулировка) нас устраивают. 

Далее нажимаем Input Properties (ввод свойств).  

Нажимаем кнопку     и из списка существующих материалов выбираем 

steel, OK. 

Затем для выбора области приложения введенных свойств нажимаем 

кнопку Select Application Region. 

Активизируем поле «Select Members» и указываем все три поверхности, 

пользуясь зоной выбора в виде прямоугольника. 

Последовательно нажимаем Add, OK и Apply. 

18. Задать граничные условия. 
Граничные условия для рассматриваемой задачи представляют собой ус-

ловия симметрии на линии отсечения моделируемой части полосы. 

Запускаем приложение «Loads/BCs» и для задания перемещений устанав-

ливаем сочетание Create/Displacement/Nodal. 

В поле «New Set Name» вводим имя вновь создаваемого набора, например 

sym. 

Нажимаем кнопку Input Data (ввод данных) и в поле «Translations» (по-

ступательные перемещения) вводим  <0,,>, что соответствует запрету пе-

ремещений в направлении оси X. OK. 

Далее нажимаем кнопку Select Application Region. Для выбора геометриче-

ских объектов устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку      (кривая или кромка) и указываем две левые 

кромки, расположенные на оси симметрии. 

Последовательно нажимаем кнопки Add, OK и Apply. 
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Отметим, что после задания условий симметрии модель имеет еще воз-

можность перемещения как жесткое целое в направлении оси Y. Поэтому 

здесь следует наложить одну дополнительную связь. 

В поле «New Set Name» вводим другое имя, например uy. 

Нажимаем кнопку Input Data и в поле «Translations» вводим  <,0,>, что со-

ответствует запрету перемещений в направлении оси Y. OK. 

Нажимаем Select Application Region.  

Активизируем поле «Select Geometry Entities», в пиктографическом меню 

выбора нажимаем кнопку       (точка или вершина) и указываем одну точ-

ку, например правую нижнюю. 

Последовательно нажимаем кнопки Add, OK и Apply. 

19. Приложить нагрузку. 
В том же приложении выбираем сочетание Create/Pressure/Element Uni-

form. 

В поле «New Set Name» вводим имя нового набора, например load. 

В качестве типа целевых элементов выбираем поверхностные, т.е. «Target 

Element Type»: 2D. 

Нажимаем кнопку Input Data и в поле «Edge Pressure» (давление на кром-

ке) вводим значение -1000 (положительное давление направлено к по-

верхности и вызывает сжатие, а в нашем случае необходимо задать растя-

жение, поэтому мы вводим отрицательное число). OK. 

Далее нажимаем кнопку Select Application Region. Для выбора геометриче-

ских объектов устанавливаем опцию «Select»: Geometry. 

Активизируем поле «Select Surfaces or Edges», в пиктографическом меню 

выбора нажимаем кнопку      (кромка) и указываем правую кромку моде-

ли. 

Последовательно нажимаем кнопки Add, OK и  Apply. 

20. Запустить задачу на счет. 
Выбираем приложение «Analysis» и устанавливаем сочетание Analyze/  

Entire Model/Full Run. 

Для изменения типа решения нажимаем кнопку Solution Type и выбираем 

Nonlinear Static (нелинейный статический анализ), OK. 

Затем для модификации расчетного случая нажимаем кнопку Subcases. 

В списке доступных расчетных случаев «Available Subcases» указываем 

Default. Данное имя должно появиться в поле «Subcase Name». 
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Для изменения параметров расчетного случая используем кнопку Subcase 

Parameters. 

В поле «Number of Load Increments» вводит число ступеней (или шагов) 

нагружения, например 25. OK. 

Для включения опции вывода промежуточных решений нажимаем кнопку 

Output Requests (запросы по выводу). В выпадающем меню «Form Type» 

(тип окна) выбираем пункт Advanced (расширенный) и устанавливаем «In-

termediate Output Option»: Yes (выводить результаты для каждого вычис-

ленного шага нагружения). 

Кроме того, для дополнительного вывода деформаций в верхнем списке 

«Select Result Type» указываем строку Element Strains (деформации в эле-

ментах), OK. 

Последовательно нажимаем  Apply и Cancel. 

И, наконец, для запуска задачи на счет нажимаем кнопку Apply основной 

диалоговой панели приложения. 

21. Присоединить файл результатов расчета к базе данных программы 

MSC.Patran. 

В том же приложении для доступа к результатам расчета устанавливаем 

сочетание Access Results/Attach XDB/Result Entities. 

Нажимаем кнопку Select Results File и в появившемся окне выбираем файл 

lab5.xdb, OK. 

В заключение нажимаем Apply. 

22. Включить анимацию распространения пластической зоны вблизи верши-

ны выреза по мере возрастания нагрузки. 

Запускаем приложение «Results» и устанавливаем сочетание Create/Fringe. 

В разделе «Select Result Cases» выбираем сразу все случаи результатов, 

соответствующие различным ступеням нагружения. При этом для раскры-

тия списка случаев результатов следует отжать кнопку      . 

В списке «Select Fringe Result» указываем строку Nonlinear Strain, Plastic 

Strain (нелинейные деформации, пластические деформации). 

Включаем опцию «Animate». 

Далее нажимаем последнюю кнопку с кинолентой      . 

Для анимации по глобальной переменной выбираем «Animation Method»: 

Global Variable. 

В поле «Number of Frames» (число кадров) вводим значение 25 для полу-

чения более плавной анимации. 
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И, наконец, нажимаем кнопку  Apply. 

Некоторое время займет формирование видео файла, после чего в графи-

ческом окне будет представлена анимация процесса распространения пла-

стической зоны. Кроме того, появится дополнительная панель «Animation 

Control». 

Скорость анимации здесь регулируется бегунком «Animation Speed». 

В случае необходимости изменения опций здесь следует временно пре-

рвать процесс анимации, установив флаг «Pause Animation». 

Для полного завершения процесса анимации необходимо нажать одну из 

кнопок раздела «Stop Animation and ...». 

Поле пластических деформаций при полной нагрузке представлено на ри-

сунке 5.6. 

 

Рисунок 5.6 – Пластические деформации 
 

23. Включить анимацию изменения поля напряжений по Мизесу по мере воз-

растания нагрузки. 

Нажимаем кнопку-пиктограмму      . 

Следует отметить, что в списке «Select Fringe Result» для многоцветного 

изображения полей напряжений содержатся три величины: Stress Tensor 

(тензор напряжений); Nonlinear Stresses, Stress Tensor (нелинейные напря-
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жения, тензор напряжений) и Nonlinear Stresses, Equivalent Stress (нели-

нейные напряжения, эквивалентное напряжение). 

Для нелинейного элемента CQUAD4 первые две величины выдают одина-

ковые значения компонент, причем напряжения zzσ  полагаются равными 

нули. Однако в случае плоской деформации это не соответствует действи-

тельности, что приводит к некорректному вычислению эквивалентных на-

пряжений. 

Поэтому для правильного расчета напряжений по Мизесу здесь следует 

указать строку Nonlinear Stresses, Equivalent Stress. 

Для включения процесса анимации нажимаем  Apply. 

Поле напряжений по Мизесу при полной нагрузке показано на рисун-

ке 5.7. 

 

Рисунок 5.7 – Поле напряжений по Мизесу (в МПа) 
 

24. Выйти из программы: File>Quit. 
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6 ИССЛЕДОВАНИЕ  СОУДАРЕНИЯ  ПОЛОГО  ШАРА   
С  НЕДЕФОРМИРУЕМОЙ  ПРЕГРАДОЙ   
ПРИ  ПОМОЩИ  CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: полый шар диаметром 30 мм и толщиной стенки 

2 мм ударяется со скоростью 90 км/ч об абсолютно жесткую поверхность (с 

отскоком), как показано на рисунке 6.1. Шар изготовлен из алюминиевого 

сплава Д1, имеющего следующие свойства: модуль упругости 7·104 МПа; ко-

эффициент Пуассона 0,3; касательный модуль (или модуль упрочнения) 

2500 МПа; предел текучести 200 МПа; плотность 2700 кг/м3. 

Допущения: поскольку форма недеформируемой преграды не имеет 

значения, она принимается в виде круглой площадки радиусом 20 мм; при 

этом задача становится осесимметричной. Диаграмма деформирования мате-

риала считается билинейной, т.е. состоящей из двух прямолинейных участ-

ков. 

Цель: исследовать напряженно-деформированное состояние шара в 

момент соударения с преградой и после отскока от нее. 

 

 

Рисунок 6.1 – Удар шара о преграду 
 

В осесимметричной постановке полый шар будем представлять его се-

чением, имеющим форму полукольца с внешним радиусом 15 мм и внутрен-
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ним – 13 мм; а недеформируемую преграду – линией длиной 20 мм, как пока-

зано на рисунке 6.2. Начало системы координат сечения поместим в центр 

преграды, причем ось  X направим вправо, а ось Y – вверх по оси симметрии. 

 

 
Рисунок 6.2 – Расчетная схема 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить пакет ANSYS, указать имя задачи Lab6. 

2. Установить тип используемых в расчете конечных элементов – 4-узловой 

плоский элемент PLANE182 с формулировкой «осесимметричное поведе-

ние»: M_M>Preprocessor>Element Type>Add/Edit/Delete. 

Нажимаем Add и выбираем  Structural Solid>Quad 4node 182, OK. 

В окне «Element types» нажимаем Options и для опции K3 устанавливаем 

значение Axisymmetric. Далее OK и Close. 

3. Задать свойства материала: M_M>Preprocessor>Material Props>Material 

Models. 

Сначала задаем линейные упругие свойства. Для этого в правом окне по-

следовательно выбираем  Structural>Linear> Elastic>Isotropic. 

Вводим: 

EX: 7e4 (модуль упругости, МПа) 

PRXY: 0.3 (коэффициент Пуассона) 

OK. 

Снова в правом окне выбираем Structural>Density и вводим: 

DENS: 2700e-12 (плотность, т/мм3) 
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OK. 

Далее определяем нелинейный участок диаграммы деформирования, вы-

бирая билинейную модель с изотропным упрочнением: Structural>  

Nonlinear>Inelastic>Rate independent>Isotropic Hardening Plasticity>Mises 

Plasticity>Bilinear. 

Вводим: 

Yield Stss: 200 (предел текучести, МПа) 

Tang Mod: 2500 (касательный модуль, МПа). 

Нажимаем кнопку Graph для отображения зависимости σ ε−  в виде гра-

фика. 

Завершаем процесс ввода кнопкой OK и закрываем панель. 

4. Построить точки: M_M>Preprocessor>Modeling>Create>Keypoints>In  

Active CS. 

Вводим координаты точек согласно следующей таблице: 

 

Номер  
точки 

x, 
 мм 

y, 
 мм 

z, 
 мм 

1 0 0 0 
2 20 0 0 

 

Включаем нумерацию геометрических объектов: U_M>PlotCtrls>  

Numbering; отмечаем флаги «Keypoint numbers», «Line numbers» и «Area 

numbers». 

5. Построить отрезок прямой линии, представляющий жесткую преграду: 

M_M>Preprocessor>Modeling>Create>Lines>Straight Line. 

Указываем сначала точку 2, а затем точку 1, OK. 

6. Построить полукольцо: M_M>Preprocessor>Modeling>Create>Areas> 

Circle>Partial Annulus. 

Вводим следующие параметры: координаты центра полукольца WP X = 0 

и WP Y = 50; внешний радиус Rad-1 = 15; начальный угол сектора  

Theta-1 = -90; внутренний радиус Rad-2 = 13; конечный угол сектора 

Theta-2 = 90. Нажимаем  OK. 

Отобразим на экране дисплея построенную геометрическую модель в виде 

линий: U_M>Plot>Lines. 

7. Разрезать построенное полукольцо на две половины. 

Данную операцию удобно выполнить с помощью рабочей плоскости. 
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7.1. Установить рабочую плоскость перпендикулярно дуге полукольца в 

ее середине: U_M>WorkPlane>Align WP with>Plane normal to line. 

Указываем одну из дуг, образующих полукольцо, OK. 

В поле «Ratio along line» (безразмерная координата вдоль линии) вво-

дим значение 0.5 (середина линии). OK. 

7.2. Разрезать все поверхности рабочей плоскостью: M_M>Preprocessor> 

Modeling>Operate>Booleans>Divide>Area by WrkPlane. 

Нажимаем Pick All. 

8. Разбить поверхности на конечные элементы: M_M>Preprocessor> 

Meshing>MeshTool. 

Для получения результатов приемлемой точности здесь следует взять хотя 

бы четыре элемента по толщине стенки шара. Учитывая данную рекомен-

дацию, глобальный размер стороны элемента примем равным 2/4 = 0,5 мм.  

Нажимаем кнопку Set строки «Global» и в поле «Element edge length» (раз-

мер длины стороны элемента) вводим значение 0.5, OK. 

Поскольку поверхности являются «правильными», то можно установить 

режим Mapped (регулярная сетка). 

Для генерации сетки нажимаем кнопку Mesh и указываем все поверхности 

(Pick All). 

9. Создать контактную пару для описания взаимодействия жесткого и де-

формируемого тел. 

Для этого сначала запускаем специальный инструмент «Contact Manager» 

(Менеджер контактов) путем нажатия одноименной кнопки пиктографи-

ческого меню программы ANSYS либо командой Main Menu> 

Preprocessor>Create>Contact Pair. 

Появляющуюся при этом диалоговую панель удобно сместить вниз, чтобы 

она не перекрывала изображение модели в рабочей области. 

В данной панели пока доступна лишь первая кнопка, предназначенная для 

вызова средств Мастера контактов «Contact Wizard». 

Нажимаем эту кнопку и создаем контактную пару, выполняя следующие 

шаги. 

9.1. Указать ответную поверхность. 

В разделе «Target Surface» в качестве объектов, используемых для оп-

ределения ответной поверхности, выбираем Lines (линии). 

В разделе «Target Type» (тип ответной поверхности) выбираем Rigid 

(абсолютно жесткая). 
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Нажимаем кнопку Pick Target и указываем прямую линию L1 (пред-

ставляющую недеформируемую преграду). 

Далее нажимаем Apply (поскольку после нажатия OK кнопка Next мо-

жет оставаться неактивной). 

На экран вернется диалоговая панель «Contact Wizard», в которой бу-

дет активна кнопка Next. 

Нажимаем Next для перехода к следующему шагу. 

9.2. Указать контактную поверхность. 

В разделе «Contact Surface» в качестве объектов, используемых для 

определения контактной поверхности, выбираем Lines (линии). 

В разделе «Contact Element Type» (тип модели контакта) выбираем 

Surface-to-Surface (поверхность – поверхность). 

Нажимаем кнопку Pick Contact и указываем линию L9 (нижнюю 

внешнюю границу полукольца). 

Далее нажимаем  Apply, а не OK.  

В диалоговой панели Мастера контактов нажимаем кнопку Next для 

перехода к следующему шагу. 

9.3. Задать параметры контакта. 

Отключаем опцию начального внедрения (проникновения) «Include 

initial penetration», которая требуется лишь в случае, когда контакти-

рующие тела имеют в начале расчета область перекрытия (как, на-

пример, при посадке диска на вал с натягом). 

Для коэффициента трения в поле «Coefficient of Friction» вводим зна-

чение 0.1. 

И, наконец, для создания собственно контактной пары нажимаем 

кнопку Create. 

9.4. Проверить ориентацию внешних нормалей к контактной и ответной 

поверхностям. 

После нажатия кнопки Create Мастер контактов переключится в ре-

жим проверки ориентации нормалей. При этом в рабочем окне будут 

изображаться лишь контактные и ответные элементы с условными 

значками, показывающими направление нормалей. 

Следует отметить, что нормали контактных и ответных элементов 

должны быть направлены навстречу друг другу. 

В нашем случае нормали контактных элементов всегда будут направ-

лены наружу (т.е. правильно). 
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Однако ориентация нормали к ответной поверхности здесь зависит от 

направления линии L1 (т.е. от порядка перечисления ее точек). 

Если нормаль к ответной поверхности направлена вниз (т.е. непра-

вильно), следует изменить ее ориентацию с помощью кнопки Flip 

Target Normal. 

Для завершения процесса создания контактной пары нажимаем кноп-

ку  Finish. Затем можно закрыть окно «Contact Manager». 

Отобразим на экране дисплея построенную геометрическую модель в 

виде линий: U_M>Plot>Lines. 

10. Задать граничные условия. 
Поскольку задача является осесимметричной, необходимо ограничить ра-

диальные перемещения всех узлов, лежащих на оси Y. 

Воспользуемся командой задания перемещений на линиях: 

M_M>Solution>Define Loads>Apply>Structural>Displacement>On Lines. 

Указываем линии L3 и L5 (лежащие на оси симметрии), OK. 

В списке «DOFs to be constrained» выбираем UX (запрет поступательных 

перемещений по оси X), OK. 

Следует отметить, что ANSYS по умолчанию автоматически закрепляет 

жесткую ответную поверхность (линию) от всех перемещений. 

11. Установить новый тип анализа – анализ переходных динамических про-

цессов: M_M>Solution>Analysis Type>New Analysis. 

Указываем анализ Transient, OK. 

Выбираем метод решения Full (полный), OK. 

12. Задать опции анализа: M_M>Solution>Analysis Type>Sol’n Controls. 

Выбираем вкладку «Basic». 

Для учета больших перемещений в списке «Analysis Options» устанавли-

ваем значение Large Displacement Transient. 

Время в конце шага нагружения (поле «Time at end of loadstep» раздела 

«Time Control») задаем равным 0.0002 (в сек). 

В поле «Number of substeps» того же раздела вводим число подшагов, на-

пример 50. 

И, наконец, для сохранения промежуточных результатов на всех подшагах 

в списке «Frequency» (частота записи выходных величин в файл результа-

тов) выбираем значение Write every substep. 
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13. Непосредственно перед запуском задачи на счет задать начальные условия 

(перемещение и скорость отдельных узлов модели в момент времени 

t = 0): M_M>Solution>Define Loads>Apply>Initial Condit’n>Define. 

В панели указания активизируем селекторную кнопку Box и, удерживая 

нажатой левую кнопку мыши, растягиваем прямоугольник выбора так, 

чтобы в него попали все узлы, относящиеся к шару. OK. 

В появившейся диалоговой панели «Define Initial Conditions» в поле «DOF 

to be specified» (определяемая степень свободы) выбираем компоненту 

UY, в поле «Initial value of DOF» (начальное перемещение) вводим -35 (в 

мм; шар смещается вниз до положения контакта с жесткой поверхностью), 

а в поле «Initial velocity» (начальная скорость) вводим -25000 (в мм/с; 

90·106/3600 = 25000). OK. 

14. Выполнить переходный динамический анализ: M_M>Solution>Solve> 

Current LS. 

Отметим, что при выходе из модуля Solution начальные условия пропада-

ют. Поэтому при повторном анализе их следует задать заново. 

15. Запустить специальный инструмент «Results Viewer», предназначенный 

для пошагового просмотра результатов расчета: M_M>General Postproc> 

Results Viewer. 

При этом на экране исчезнет главное меню и появится дополнительная 

панель, вид которой показан на рисунке 6.3. 

 

 
Рисунок 6.3 – Панель управления пошаговым отображением результатов 

 

15.1. Изобразить эпюру контактного давления. 

Список результатов 

Тип отображения 

Полоса подшагов 

Анимация результатов 

Изображение результатов 

Средства просмотра результатов в  
постпроцессоре истории нагружения 
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В списке результатов выбираем Nodal Solution>Contact>Contact  

Pressure (контактное давление) и нажимаем кнопку Plot Results (изо-

бражение результатов). 

Далее, перемещая движок по полосе подшагов, можно наблюдать 

картину изменения величины контактного давления в различные мо-

менты времени в рассчитанном интервале. 

Эпюра контактного давления на первом подшаге представлена на 

рисунке 6.4. 

 

 
Рисунок 6.4 – Эпюра контактного давления (в МПа) 

 

Отметим, что контактное взаимодействие здесь длится примерно 

0,00009 с, после чего происходит разъединение тел (отскок шара). 

Аналогичным образом можно анализировать и другие расчетные ве-

личины, входящие в список доступных результатов. Например, ин-

терес могут представлять пластические деформации после соударе-

ния и область их локализации: Nodal Solution>Plastic Strain>von 

Mises Plastic strain. 

15.2. Включить анимацию изображения результатов расчета. 

Нажимаем кнопку Animate Results (анимация результатов) в панели 

«Result Viewer». 
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При этом появляется новая диалоговая панель, где в разделе «Type of 

Animation Sequence to Capture» в качестве типа анимации следует 

указать Over time (по времени), OK. 

В следующем окне в поле «Number of animations frames» (количество 

кадров анимации) вводим число в интервале от 10 до 100 (чем боль-

ше кадров, тем более плавной будет анимация, но более затратным 

будет процесс записи видео файла), в поле «Animation time delay» 

(время задержки между кадрами, сек) вводим 0.1 и в списке «Contour 

data for animation» выбираем Use Last Display (использовать послед-

нее изображение) либо другую выходную величину. 

Нажатие кнопки OK приводит к формированию и отображению на 

экране анимированного представления выбранной величины. 

15.3. Построить зависимость пластической деформации от времени. 

В панели «Result Viewer» нажимаем кнопку Time-History Variable 

Viewer (средства просмотра результатов в постпроцессоре истории 

нагружения). 

Для задания новой переменной нажимаем кнопку Add Data. 

В списке «Result Item» последовательно указываем Nodal Solution> 

Plastic Strain>von Mises plastic strain (эквивалентная пластическая 

деформация по Мизесу). 

В поле «Variable Name» (имя переменной) вводим epl. OK.  

Далее на экране при помощи мыши указываем самый нижний узел 

шара. OK. 

Затем в списке выбираем переменную epl и нажимаем кнопку Graph 

Data. В результате получим график зависимости пластической де-

формации от времени в указанной точке шара (рисунок 6.5). 

16. Для отчета по работе записать в файл протокол команд базы данных: 

U_M>File>Write DB Log File. 

Вводим имя Lab6.lgw. 

17. Выйти из программы: ANSYS Toolbar>QUIT. 
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Рисунок 6.5 – График зависимости пластической деформации от времени 
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7 РАСЧЁТ  БОЛТОВОГО  СОЕДИНЕНИЯ  С  
ПРЕДВАРИТЕЛЬНОЙ  ЗАТЯЖКОЙ   
ПРИ  ПОМОЩИ  CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: две круглые пластины диаметром 67 мм разной тол-

щины (15 мм и 9 мм) скреплены болтом М6, поставленным с зазором 0,5 мм. 

Сила предварительной затяжки болта составляет 861 Н. Предполагается, что 

нижняя пластина жестко закреплена по внешнему контуру, а на верхнюю 

пластину действует распределенная по окружности нагрузка интенсивностью 

15q = Н/мм, как показано на рисунке 7.1. Пластины изготовлены из алюми-

ниевого сплава (модуль упругости 7·104 МПа; коэффициент Пуассона 0,3), а 

болт и гайка – из стали (модуль упругости 2,1·105 МПа; коэффициент Пуас-

сона 0,3). 

Допущение: головка болта и гайка имеют цилиндрическую форму без 

граней под ключ, что позволяет ограничиться решением осесимметричной 

задачи.  

Цель: исследовать напряженно-деформированное состояние болтового 

соединения; проверить раскрытие стыка соединяемых деталей под нагрузкой. 

 

       

Рисунок 7.1 – Болтовое соединение пластин 
 

В осесимметричной постановке болтовое соединение будем представ-

лять его сечением, параметрические размеры которого показаны на рисун-

ке 7.2. Начало системы координат поместим в центр нижней поверхности 

гайки, причем ось  X направим вправо, а ось Y – вверх по оси симметрии. 
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Рисунок 7.2 – Расчетная схема 

 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить пакет ANSYS, указать имя задачи Lab7. 

2. Установить тип используемых в расчете конечных элементов – 4-узловой 

плоский элемент PLANE182 с формулировкой «осесимметричное поведе-

ние»: M_M>Preprocessor>Element Type>Add/Edit/Delete. 

Нажимаем Add и выбираем  Structural Solid>Quad 4node 182, OK. 

В окне «Element types» нажимаем Options и для опции K3 устанавливаем 

значение Axisymmetric. Далее OK и Close. 

3. Задать свойства материала: M_M>Preprocessor>Material Props>Material 

Models. 

Сначала определяем первую модель материала (Material Model Number 1), 

содержащую свойства стали. Для этого в правом окне последовательно 

выбираем  Structural>Linear>Elastic>Isotropic. 

Вводим: 

EX: 2.1e5 (модуль упругости стали, МПа) 

PRXY: 0.3 (коэффициент Пуассона стали) 

OK. 

Добавляем вторую модель материала со свойства алюминиевого сплава.  

В меню «Material» панели «Define Material Model Behavior» выбираем 

пункт «New model». В появившемся окне «Define material ID» в поле «De-

fine material ID» вводим номер 2 и нажимаем кнопку OK. 
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При этом в левом окне «Material Models Defined», где содержится список 

имеющихся моделей материалов, появляется новая запись: Material Model 

Number 2. 

Далее в правом окне «Material Models Available» последовательно выбира-

ем  Structural>Linear>Elastic>Isotropic. 

В соответствующие поля вводим: 

EX: 7e4 (модуля упругости алюминиевого сплава, МПа) 

PRXY: 0.3 (коэффициента Пуассона алюминиевого сплава) 

Завершаем процесс ввода кнопкой OK и закрываем панель. 

4. Для удобства ввода исходных данных определить скалярные параметры: 

U_M>Parameters>Scalar Parameters. 

В поле «Selection» последовательно вводим значения параметров, харак-

теризующих размеры сечения (см. рисунок 7.2): d=6; z=0.5; h=0.7*d; 

h0=0.8*d; h1=15; h2=9. После каждого ввода здесь необходимо нажать 

кнопку Accept (принять). Закрываем панель кнопкой Close. 

5. Построить геометрическую модель сечения болтового соединения. 

Как видно из рисунка 7.2, данная модель может быть получена при помо-

щи комбинирования прямоугольников. 

5.1. Построить прямоугольники, представляющие сечения болта и гайки: 

M_M>Preprocessor>Modeling>Create>Areas>Rectangle>By 2 Cor-

ners. 

Для первого прямоугольника (цилиндрическая часть болта) вводим 

следующие параметры: координаты левого нижнего угла WP X = 0 и 

WP Y = 0; ширина Width = d/2; высота Height = h0+h1+h2+h. Нажима-

ем кнопку Apply (применить) для продолжения данной операции. 

Для второго прямоугольника (гайка) задаем: WP X = 0; WP Y = 0; 

Width = d; Height = h0. Apply. 

Для третьего прямоугольника (головка болта) вводим: WP X = 0; 

WP Y = h0+h1+h2; Width = d; Height = h. Завершаем построение сече-

ния крепежной пары кнопкой OK. 

5.2. Построить прямоугольники, представляющие сечения скрепляемых 

деталей. 

Переместим сначала рабочую плоскость так, чтобы ось WP X была 

направлена вдоль линии опирания гайки на деталь, а ось WP Y от-

стояла на 0,5 мм от цилиндрической части болта (для образования за-

зора между болтом и деталями): U_M>WorkPlane>Offset WP to>XYZ 
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Locations. В панели указания активизируем опцию «Global Cartesian» 

(глобальные декартовы координаты) и в поле ниже вводим: 

d/2+z,h0,0. Нажимаем OK. 

Опять выбираем команду M_M>Preprocessor>Modeling>Create>  

Areas>Rectangle>By 2 Corners. 

Строим четвертый прямоугольник со следующими параметрами: 

WP X = 0; WP Y = 0; Width = 1.5*d; Height = h1. Apply. 

Завершаем формирование сечения нижней пластины построением пя-

того прямоугольника: WP X = 1.5*d; WP Y = 0; Width = 3.5*d; 

Height = h1. Apply. 

В заключение аналогично строим шестой и седьмой прямоугольники, 

представляющие сечение верхней пластины.  

Для шестого прямоугольника: WP X = 0; WP Y = h1; Width = d; 

Height = h2. Apply. 

Для седьмого: WP X = d; WP Y = h1; Width = 4*d; Height = h2. Завер-

шаем построение кнопкой OK. 

Включаем нумерацию геометрических объектов: U_M>PlotCtrls>  

Numbering; отмечаем флаг «Area numbers». 

Для удобства дальнейших построений можно скрыть изображение 

рабочей плоскости: U_M>WorkPlane>Display Working Plane. 

5.3. Выполнить булеву операцию перекрытия поверхностей, образующих 

крепежную пару: M_M>Preprocessor>Modeling>Operate>Booleans> 

Overlap>Areas. 

Указываем поверхности A1, A2 и A3. OK. 

5.4. Склеить попарно поверхности, образующие каждую из скрепляемых 

деталей: M_M>Preprocessor>Modeling>Operate>Booleans>Glue>  

Areas. 

Сначала указываем поверхности A4 и A5 (нижняя пластина), Apply. 

Затем указываем поверхности A6 и A7 (верхняя пластина), OK. 

Геометрическая модель построена. 

6. Разбить геометрическую модель на конечные элементы: M_M>  

Preprocessor>Meshing>MeshTool. 

Здесь сначала следует назначить атрибуты поверхностям, так как в рас-

сматриваемой задаче используются два материала. 
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Для этого в разделе «Element Attributes» диалоговой панели «MeshTool» в 

выпадающем списке выбираем Areas (поверхности), рядом нажимаем 

кнопку Set. 

Указываем поверхности A8, A9, A10, A11 и A12, представляющие эле-

менты крепежа (изготовленные из стали), OK. 

Появляется диалоговая панель «Area Attributes», где по умолчанию уста-

новлены следующие значения: 

 MAT «Material number»: 1 (номер материала) 

 TYPE «Element type number»: 1 PLANE182 (номер типа элементов). 

Поскольку они нас устраивают, нажимаем Apply. 

Теперь указываем поверхности A1, A2, A4 и A6, описывающие соединяе-

мые пластины из алюминиевого сплава, OK.  

В поле «Material number» выбираем номер 2 (модель материала для алю-

миниевого сплава). OK. 

В разделе «Size Controls» устанавливаем глобальный размер элементов с 

помощью кнопки Set строки «Global»; в поле «Element edge length» (длина 

стороны элемента) вводим значение 1 (в мм), OK. 

Далее в списке «Mesh» в качестве объектов для разбиения выбираем Areas 

(поверхности), в поле «Shape» (форма элементов) указываем Quad (четы-

рехугольная). И, наконец, выбираем режим построения регулярной сетки 

Mapped, так как все поверхности имеют «правильную» топологию. 

После нажатия кнопки Mesh указываем все поверхности (Pick All). 

Получаемая здесь разбивка изображена на рисунке 7.3. 

 

 
Рисунок 7.3 – Сетка конечных элементов 
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Далее удобно включить нумерацию линий: U_M>PlotCtrls>Numbering; 

отмечаем флаг «Line numbers». 

7. Создать контактную пару для описания взаимодействия скрепляемых пла-

стин. 

Для этого сначала запускаем специальный инструмент «Contact Manager» 

(Менеджер контактов) путем нажатия одноименной кнопки пиктографи-

ческого меню программы ANSYS либо командой M_M>Preprocessor> 

Create>Contact Pair. 

В появившейся панели нажимаем первую кнопку, предназначенную для 

вызова средств Мастера контактов «Contact Wizard», и создаем контакт-

ную пару между скрепляемыми пластинами, выполняя следующие шаги. 

7.1. Указать ответную поверхность. 

В разделе «Target Surface» в качестве объектов, используемых для оп-

ределения ответной поверхности, выбираем Lines (линии). 

В разделе «Target Type» (тип ответной поверхности) выбираем Flexi-

ble (деформируемая поверхность). 

Нажимаем кнопку Pick Target и указываем линии L4 и L15 (представ-

ляющие верхнюю границу нижней более толстой пластины). 

Далее нажимаем Apply (поскольку после нажатия OK кнопка Next мо-

жет оставаться неактивной). 

На экран вернется диалоговая панель «Contact Wizard», в которой бу-

дет активна кнопка Next. 

Нажимаем Next для перехода к следующему шагу. 

7.2. Указать контактную поверхность. 

В разделе «Contact Surface» в качестве объектов, используемых для 

определения контактной поверхности, выбираем Lines (линии). 

В разделе «Contact Element Type» (тип модели контакта) выбираем 

Surface-to-Surface (поверхность – поверхность). 

Нажимаем кнопку Pick Contact и указываем линии L5 и L21 (пред-

ставляющие нижнюю границу верхней пластины). 

Далее нажимаем  Apply, а не OK.  

В диалоговой панели Мастера контактов нажимаем кнопку Next для 

перехода к следующему шагу. 

7.3. Задать параметры контакта. 

Отключаем опцию начального внедрения (проникновения) «Include 

initial penetration». 
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Для коэффициента трения в поле «Coefficient of Friction» вводим зна-

чение 1.1 (алюминий-алюминий, чистая несмазанная поверхность). 

И, наконец, для создания собственно контактной пары нажимаем 

кнопку Create. 

Для завершения процесса создания контактной пары в последнем ин-

формационном окне нажимаем кнопку Finish. 

8. Создать контактную пару для описания взаимодействия гайки и нижней 

пластины. 

В панели Менеджера контактов снова нажимаем кнопку для вызова 

средств Мастера контактов и создаем вторую контактную пару, выполняя 

те же шаги, что и в предыдущем случае. Однако в качестве ответной по-

верхности указываем линию L13 (короткая линия нижней границы ниж-

ней пластины), а за контактную – принимаем линию L36 (верхний край 

гайки). Для коэффициента трения вводим значение 0.6 (сталь-алюминий, 

чистая несмазанная поверхность). 

9. Создать контактную пару для описания взаимодействия головки болта и 

верхней пластины. 

В панели Менеджера контактов опять нажимаем кнопку для вызова 

средств Мастера контактов и создаем третью контактную пару, выполняя 

те же шаги, что и в предыдущих случаях. Однако в качестве ответной по-

верхности указываем линию L23 (короткая линия верхней границы верх-

ней пластины), а за контактную – принимаем линию L38 (нижний край 

головки болта). Коэффициент трения равен 0,6. 

В конце следует закрыть диалоговую панель Менеджера контактов. 

Отобразим на экране дисплея построенную геометрическую модель в виде 

линий: U_M>Plot>Lines. 

10. Создать дополнительный узел для учета затяжки болта: M_M>  

Preprocessor>Modeling>Create>Nodes>In Active CS.  

Для удобства дальнейшего использования этого узла ему следует присво-

ить легко запоминающийся номер (заведомо превышающий число узлов в 

модели), например 9999. Положение данного узла не имеет существенно-

го значения, главное чтобы он был легко доступным при графическом 

указании. 

Учитывая это, в поле «Node number» (номер узла) вводим 9999, а в поля 

«X, Y, Z Location in active CS» (координаты узла в активной системе коор-

динат) – соответственно  6*d; h+h1; 0. OK. 
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Отобразим поверхности: U_M>Plot>Areas. 

11. Сгенерировать элементы предварительной затяжки болта: M_M>  

Preprocessor>Modeling>Create>Elements>Pretension>Pretensn Mesh>  

Elements in Area. 

Указываем цилиндрическую часть болта – поверхность A12; OK. 

Указываем произвольный узел на оси Y в сечении цилиндрической части 

болта, например, узел, находящийся напротив линии стыка алюминиевых 

деталей, OK. 

Далее в поле «Section number» (номер сечения) вводим 1, в поле «Section 

name» (имя сечения) – Bolt и в поле «Pretension node» (контрольный узел 

предварительной затяжки) – номер, созданного вручную узла, т.е. 9999. В 

списке «Separation coord system» (система координат разъединения) ука-

зываем Global Cartesian; а в списке «Separatn surface norm to» (нормаль к 

поверхности разъединения) выбираем Y-axis. OK. 

В результате выполнения данной операции конечные элементы, модели-

рующие болт, делятся на две несвязанные группы, между которыми и соз-

даются элементы предварительной затяжки. При этом усилие затяжки бу-

дет действовать по направлению нормали к поверхности разъединения. 

Следует отметить, что при каждом изменении сетки в центральной части 

болта необходимо заново генерировать элементы предварительной затяж-

ки. 

12. Задать граничные условия. 
Поскольку задача является осесимметричной, необходимо ограничить ра-

диальные перемещения всех узлов, лежащих на оси Y. 

Кроме того, следует жестко закрепить наружный край нижней пластины. 

Воспользуемся командой задания перемещений на линиях: 

M_M>Solution>Define Loads>Apply>Structural>Displacement>On Lines. 

Указываем линии L29, L33 и L39 (т.е. все линии, лежащие на оси симмет-

рии), OK. 

В списке «DOFs to be constrained» выбираем UX (запрет поступательных 

перемещений по оси X), Apply. 

Далее указываем линию L18 (наружный край нижней пластины), OK. 

В списке «DOFs to be constrained» выбираем All DOF (запрет всех пере-

мещений), OK. 

13. Приложить усилие предварительной затяжки: M_M>Solution>Define 

Loads>Apply>Structural>Force/Moment>on Nodes. 



 80

Указываем контрольный узел 9999, имеющий только одну степень свобо-

ды. OK.  

Затем в списке «Direction of force/mom» (направление силы/момента) вы-

бираем направление FX и в поле «Force/moment value» вводим значение 

861 (в Н). OK. 

Следует отметить, что графическое изображение силы здесь не имеет фи-

зического смысла. 

14. Сохранить базу данных: ANSYS Toolbar>SAVE_DB. 

База данных записывается в файл  Lab7.db. 

15. Задать опции анализа: M_M>Solution>Analysis Type> Sol’n Controls. 

Отметим, что процесс нагружения для рассматриваемой задачи разбивает-

ся на два шага. При этом на первом шаге производится затяжка соедине-

ния, а на втором прикладывается основная нагрузка по контуру верхней 

пластины. 

Выбираем вкладку «Basic». В поле «Number of substeps» раздела «Time 

Control» вводим число подшагов, например 30. 

Для сохранения промежуточных результатов на всех подшагах в списке 

«Frequency» (частота записи выходных величин в файл результатов) вы-

бираем значение Write every substep. 

16. Выполнить анализ первого шага нагружения: M_M>Solution>Solve>  

Current LS. 

По окончании решения, не выходя из модуля Solution, необходимо задать 

нагрузку на втором шаге и повторно запустить задачу на счет, как описано 

далее. 

Отобразим конечно-элементную модель: U_M> Plot>Elements. 

17. Зафиксировать затяжку. 
Для этого сначала удаляем силу затяжки FX=891 Н в узле 9999: 

M_M>Solution>Define Loads>Delete>Structural>Force/Moment>On Nodes. 

Указываем узел 9999, OK. 

В списке «Force/moment to be deleted» выбираем компоненту FX. OK. 

Затем в этом узле для перемещения UX следует задать значение %_FIX% 

(включая два символа процента и знак подчеркивания): M_M>Solution> 

Define Loads>Apply>Structural>Displacement>on Nodes 

Опять указываем узел 9999, OK. 

В поле «DOFs to be constrained» выбираем UX и в поле «Displacement 

value» вводим %_FIX%. OK.  
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Появившееся предупреждение о том, что имя _FIX является зарезервиро-

ванным служебным именем, следует проигнорировать. 

18. Приложить основную нагрузку. 

Напомним, что при решении осесимметричной задачи при задании погон-

ной кольцевой нагрузки q  следует вводить полное значение силы 

2 2 24,5 15 2309rqπ π= ⋅ ⋅ = Н (где 2 49 2 24,5r d= = = мм – радиус окруж-

ности, по которой действует погонная нагрузка q ). 

Воспользуемся командой задания сил в точках: M_M>Solution>Define 

Loads>Apply>Structural>Force/Moment>On Keypoints. 

Указываем правую верхнюю точку сечения верхней пластины (т.е. точку 

21), OK. 

В списке «Direction of force/mom» (направление силы/момента) выбираем 

направление FY и в поле «Force/moment value» вводим число 2309. OK. 

19. Выполнить анализ второго шага нагружения: M_M>Solution>Solve>  

Current LS. 

20. Запустить специальный инструмент «Results Viewer», предназначенный 

для пошагового просмотра результатов расчета: M_M>General Postproc> 

Results Viewer. 

20.1. Изобразить эпюру контактного давления. 
В списке результатов выбираем Nodal Solution>Contact>Contact  

Pressure (контактное давление) и нажимаем кнопку Plot Results (изо-

бражение результатов). 

Далее, перемещая движок по полосе подшагов, можно наблюдать 

картину изменения величины контактного давления в различные мо-

менты времени в рассчитанном интервале. 

По умолчанию время в конце первого шага составляет 1 с, а второго 

–  2 с. 

Отметим, что при раскрытии стыка пропадает контактное давление 

между соединяемыми пластинами. В нашем случае это происходит в 

момент времени 1,47 с, что соответствует нагрузке 

раск (1,47 1) 0,47 15 7,05q q= − = ⋅ = Н/мм. 

Эпюра контактного давления в конце первого шага представлена на 

рисунке 7.4. 
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Рисунок 7.4 – Эпюра контактного давления (в МПа) после затяжки болта 

 

20.2. Построить зависимость осевых напряжений в цилиндрической части 

болта от времени (параметра нагружения). 

В панели «Result Viewer» нажимаем кнопку Time-History Variable 

Viewer (средства просмотра результатов в постпроцессоре истории 

нагружения). 

Для задания новой переменной нажимаем кнопку Add Data. 

В списке «Result Item» последовательно указываем Nodal Solution> 

Stress>Y-Component of stress (Y-компонента напряжений). В поле 

«Variable Name» (имя переменной) вводим SY. OK. Далее на экране 

при помощи мыши указываем узел на оси круговой симметрии в се-

редине цилиндрической части болта. OK. 

Затем в списке выбираем переменную SY и нажимаем кнопку Graph 

Data. В результате получим график зависимости осевых напряжений 

от параметра нагружения в указанной точке болта (рисунок 7.5), где 

можно выделить три участка. Первый прямолинейный участок (от 0 

до 1 с) соответствует предварительной затяжке болта, т.е. первому 

шагу нагружения. Далее прикладывается основная нагрузка q , т.е. 

выполняется второй шаг. При этом, когда стык закрыт (от 1 до 

1,47 с), рассматриваемая зависимость, как видно, является нелиней-

ной. И, наконец, третий прямолинейный участок (от 1,47 до 2 с) ха-

рактеризует нагружение болта после раскрытия стыка. 
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Рисунок 7.5 – График зависимости напряжений в цилиндрической части болта 

от параметра нагружения 
 

21. Для отчета по работе записать в файл протокол команд базы данных: 

U_M>File>Write DB Log File. 

Вводим имя Lab7.lgw. 

22. Выйти из программы: ANSYS Toolbar>QUIT. 
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8 МОДЕЛИРОВАНИЕ  ГИБКИ  ПРОВОЛОКИ  ПРИ ПОМОЩИ  
ЖЁСТКИХ  РОЛИКОВ  В  СРЕДЕ  CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: стальная проволока диаметром 2 мм установлена в 

гибочном устройстве, представляющем две пары жёстких роликов диамет-

ром 10 и 4 мм (рисунок 8.1). Расстояние между осями роликов составляет 

9 мм. Меньший ролик может перемещаться, обкатывая и прижимая заготовку 

к неподвижному ролику большего диаметра. Один торец проволоки жёстко 

защемлён. Коэффициент трения между роликом и проволокой равен 0,05. 

Материал проволоки – сталь 17Х18Н9 ( 52 10E = ⋅ МПа; 0,3µ = ; 

в 570σ = МПа; 0,2 200σ = МПа; т 1000E = МПа). 

Допущение: ролики считаются абсолютно жёсткими.  

Цель: выполнить моделирование операции гибки при помощи жёстких 

цилиндров с ведущим узлом; исследовать изменение напряжённо-

деформированное состояние проволоки в процессе данной операции. 

 

 
Рисунок 8.1 – Гибочное устройство 

 

Благодаря симметрии конструкции здесь можно ограничиться модели-

рованием лишь половины проволоки. 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить пакет ANSYS, указать имя задачи Lab8. 

2. Установить тип используемых в расчёте элементов – 8-узловой шести-

гранный объёмный элемент SOLID185: M_M>Preprocessor>Element 

Type>Add/Edit/Delete. 

Нажимаем Add и выбираем Structural Solid>Brick 8node 185, OK. 

135° 
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3. Задать свойства материала: M_M>Preprocessor>Material Props>Material 

Models. 

В правом окне последовательно выбираем Structural>Linear>Elastic>  

Isotropic. 

Вводим: 

EX: 2e5 (модуль упругости, МПа) 

PRXY: 0.3 (коэффициент Пуассона) 

OK. 

Далее для задания нелинейных свойств выбираем билинейную модель де-

формирования с изотропным упрочнением: Structural>Nonlinear>  

Inelastic>Rate Independent>Isotropic Hardening Plasticity>Mises Plasticity> 

Bilinear. 

Вводим: 

 Yield Stss: 200 (предел текучести, МПа) 

 Tang Mod: 1000 (касательный модуль, МПа) 

OK. 

Закрываем панель. 

4. Построить сектор цилиндра радиусом 1 мм, длиной 30 мм, с углом рас-

твора 90°: M_M>Preprocessor>Modeling>Create>Cylinder>By Dimension. 

Вводим следующие параметры: внешний и внутренний радиусы RAD1 = 1 

и RAD2 = 0; координаты нижнего и верхнего оснований Z1 = 0 и Z2 = 30; 

начальный и конечный углы сектора THETA1 = 0 и THETA2 = 90. 

OK. 

При этом основания цилиндра будут параллельны рабочей плоскости, а 

его ось будет проходить через начало координат этой плоскости. 

Далее удобно установить изометрическую проекцию. 

5. Разбить объём на конечные элементы: M_M>Preprocessor>Meshing> 

MeshTool. 

Нажимаем кнопку Set строки «Lines» и указываем одну из направляющих 

цилиндра, например дугу L3, OK. 

В поле «No. of element divisions» (число делений на элементы) вводим 

значение 4, Apply. 

Далее указываем две образующие цилиндра и его осевую линию (т.е. L7, 

L8 и L9), OK. 

В поле «No. of element divisions» вводим число делений на элементы: 20. 
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Для сгущения сетки к середине линии в поле «Spacing ratio» вводим отри-

цательное число -0.3, OK. 

В списке «Mesh» в качестве объектов для разбиения выбираем Volumes 

(объёмы), в поле «Shape» указываем Hex (форма гексаэдра). 

Используем режим Mapped (регулярная сетка). 

После нажатия кнопки Mesh указываем объём V1, OK. 

Получаемая здесь разбивка представлена на рисунке 8.2. 

 

 
Рисунок 8.2 – Сетка на четверти цилиндра 

 

6. Зеркально отобразить построенный объём вместе с конечно-элементной 

сеткой относительно плоскости XZ: M_M>Preprocessor>Modeling> 

Reflect>Volumes. 

Указываем объём V1, OK. 

Используем следующие значения: 

 «Plane of symmetry»: X-Z plane Y (плоскость симметрии) 

 «Items to be reflected»: Volumes and mesh (объекты, которые должны 

отображаться – объёмы и сетка) 

 «Existing volumes will be»: Copied (исходные объёмы будут копиро-

ваться) 

OK. 

7. Выполнить слияние совпадающих объектов для обеспечения непрерывно-
сти модели: M_M>Preprocessor>Numbering Ctrls>Merge Items. 

В поле «Type of item to be merge», определяющем тип объектов для слия-

ния, выбираем All, OK. 
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8. Совместить рабочую плоскость с глобальной плоскостью YZ: U_M> 

WorkPlane>Offset WP by Increments. 

В диалоговой панели «Offset WP» вводим: 

 «XY,YZ,ZX Angles»: 0,0,90 (углы поворота, град) 

OK. 

9. Для моделирования роликов построить цилиндры с основаниями, лежа-

щими в глобальной плоскости YZ: M_M>Preprocessor>Modeling>Create> 

Cylinder>Solid Cylinder. 

Для неподвижного ролика вводим следующие параметры: WP X = -10 и 

WP Y = -6; Radius = 5; Depth = 3, Apply. 

Для подвижного ролика: WP X= -10 и WP Y = 3; Radius = 2; Depth = 3, OK. 

10. Удалить построенные на предыдущем шаге объёмы, оставив при этом 

входящие в их состав объекты нижних уровней: M_M>Preprocessor> 

Modeling>Delete>Volumes only. 

Указываем объёмы, описывающие геометрию роликов (т.е. V3 и V4), OK. 

Далее удобно изобразить на экране лишь поверхности (U_M>Plot>Areas). 

11. Удалить торцевые поверхности, оставшиеся после удаления цилиндриче-

ских объёмов: M_M>Preprocessor>Modeling>Delete>Areas only. 

Указываем четыре круглые торцевые поверхности (т.е. A9, A11, A14 и 

A15), OK. 

Полученная таким образом геометрическая модель показана на рисун-

ке 8.3. 
 

 
Рисунок 8.3 – Геометрическая модель с нумерацией поверхностей 
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12. Создать контактную пару для описания взаимодействия неподвижного аб-

солютно жёсткого ролика и деформируемой проволоки. 

Для этого сначала запускаем специальный инструмент «Contact Manager» 

(Менеджер контактов) путём нажатия одноимённой кнопки пиктографи-

ческого меню программы ANSYS либо командой M_M>Preprocessor> 

Create>Contact Pair. 

В появившейся панели нажимаем первую кнопку, предназначенную для 

вызова средств Мастера контактов «Contact Wizard», и создаём контакт-

ную пару между неподвижным большим роликом и поверхностью прово-

локи, выполняя следующие шаги. 

12.1. Указать ответную поверхность. 

В разделе «Target Surface» в качестве объектов, используемых для оп-

ределения ответной поверхности, выбираем Areas (поверхности). 

В разделе «Target Type» (тип ответной поверхности) выбираем Rigid 

(абсолютно жёсткая). 

Нажимаем кнопку Pick Target и указываем обе цилиндрические по-

верхности ролика большого диаметра (т.е. A12 и A13). 

Далее нажимаем Apply (поскольку после нажатия OK кнопка Next мо-

жет оставаться неактивной). 

На экран вернётся диалоговая панель «Contact Wizard», в которой бу-

дет активна кнопка Next. 

Нажимаем Next для перехода к следующему шагу. 

12.2. Указать контактную поверхность. 

В разделе «Contact Surface» в качестве объектов, используемых для 

определения контактной поверхности, выбираем Areas (поверхности). 

В разделе «Contact Element Type» (тип модели контакта) выбираем 

Surface-to-Surface (поверхность – поверхность). 

Нажимаем кнопку Pick Contact и указываем нижнюю цилиндриче-

скую поверхность проволоки (т.е. A8). 

Далее нажимаем  Apply, а не OK.  

В диалоговой панели Мастера контактов нажимаем кнопку Next для 

перехода к следующему шагу. 

12.3. Задать параметры контакта. 

Отключаем опцию начального внедрения (проникновения) «Include 

initial penetration». 
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Для коэффициента трения в поле «Coefficient of Friction» вводим зна-

чение 0.05. 

И наконец, для создания собственно контактной пары нажимаем 

кнопку Create, а затем Finish. 

13. Создать контактную пару для описания взаимодействия подвижного абсо-

лютно жёсткого ролика и проволоки. 

Снова открываем Мастер контактов «Contact Wizard» и выполняем сле-

дующие шаги. 

13.1. Указать ответную поверхность. 

В разделе «Target Surface» в качестве объектов, используемых для оп-

ределения ответной поверхности, выбираем Areas. 

В разделе «Target Type» указываем Rigid w/Pilot (абсолютно жёсткая с 

ведущим, или "пилотным", узлом). 

Нажимаем кнопку Pick Target и указываем обе цилиндрические по-

верхности ролика малого диаметра (т.е. A16 и A17), Apply. 

Нажимаем Next для перехода к следующему шагу. 

13.2. Определить положение ведущего узла. 
Выбираем опцию «Create an extra node in active CS» для явного указа-

ния местоположения узла в активной системе координат. 

Ниже вводим координаты (в мм): X = 10; Y = -6; Z = 10. 

Таким образом, ведущий узел помещаем на продолжение оси непод-

вижного ролика. 

Нажимаем Next для перехода к следующему шагу. 

13.3. Указать контактную поверхность. 

В разделе «Contact Surface» в качестве объектов, используемых для 

определения контактной поверхности, выбираем Areas. 

В разделе «Contact Element Type» выбираем Surface-to-Surface. 

Нажимаем кнопку Pick Contact и указываем верхнюю цилиндриче-

скую поверхность проволоки (т.е. A3),  Apply. 

Нажимаем Next для перехода к следующему шагу. 

13.4. Задать параметры контакта. 

Отключаем опцию начального внедрения «Include initial penetration». 

Для коэффициента трения в поле «Coefficient of Friction» вводим зна-

чение 0.05. 

Для завершения процесса создания контактной пары последовательно 

нажимаем кнопки Create и Finish. 
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В конце следует закрыть диалоговую панель Менеджера контактов. 

14. Задать граничные условия. 
Рассматриваемая проволока жёстко защемлён по правому торцу (см. ри-

сунок 8.1). 

Воспользуемся командой задания перемещений на поверхностях M_M> 

Solution>Define Loads>Apply> Structural>Displacement>On Areas. 

Указываем две поверхности на правом торце проволоки (т.е. A1 и A6), 

OK. 

В поле «DOFs to be constrained» выбираем All DOF (все степени свободы). 

OK. 

Кроме того, здесь необходимо приложить граничные условия симметрии, 

поскольку моделировалась лишь половина данной конструкции: M_M> 

Solution>Define Loads>Apply>Structural>Displacement>Symmetry B.C.>On 

Areas. 

Указываем две поверхности в плоскости разреза проволоки (т.е. A5 и 

A10), OK. 

Следует отметить, что абсолютно жёсткие элементы роликов закрепляют-

ся автоматически по всем степеням свободы, для которых явно не заданы 

перемещения. 

15. Задать нагрузку. 
В качестве нагрузки в рассматриваемой задаче выступает поворот малого 

ролика относительно оси неподвижного ролика на угол 135° (2,356 рад).  

Для задания перемещений в узлах выбираем команду M_M>Solution>  

Define Loads>Apply>Structural>Displacement>On Nodes. 

Указываем ведущий узел жёсткого элемента, лежащий на оси большого 

ролика (наиболее удалённый от плоскости YZ). OK. 

В списке «DOFs to be constrained» выбираем ROTX (угол поворота отно-

сительно оси X), а в поле «Displacement Value» вводим 2.356 (в рад). 

OK. 

16. Задать опции анализа: M_M>Solution>Analysis Type>Sol’n Controls. 

Настоящая задача является геометрически и физически нелинейной, по-

этому для учёта больших перемещений (и деформаций) в списке «Analysis 

Options» выбираем значение Large Displacement Static. 

В поле «Number of substeps» раздела «Time Control» вводим число подша-

гов, например 100. 
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Для сохранения промежуточных результатов на каждом десятом подшаге 

в списке «Frequency» (частота записи выходных величин в файл результа-

тов) выбираем значение Write every Nth substep и вводим «where N» = 10. 

OK. 

17. Сохранить базу данных: ANSYS Toolbar>SAVE_DB. 

База данных записывается в файл  Lab8.db. 

18. Выполнить статический анализ: M_M>Solution>Solve>Current LS. 

19. Запустить специальный инструмент «Results Viewer», предназначенный 

для пошагового просмотра результатов расчёта: M_M>General Postproc> 

Results Viewer. 

19.1. Изобразить поле напряжений по Мизесу. 

В списке результатов выбираем Nodal Solution>Stress>von Mises 

stress  и нажимаем кнопку Plot Results. 

Далее, перемещая движок по полосе подшагов, можно наблюдать 

картину изменения величины эквивалентного напряжения в различ-

ные моменты времени в рассчитанном интервале. 

Поле напряжений по Мизесу на последнем подшаге показано на ри-

сунке 8.4. Здесь предварительно установлен вид на модель слева 

(кнопка Left View). 

 

 
Рисунок 8.4 – Поле напряжений по Мизесу (в МПа) 

 

Аналогичным образом можно анализировать и другие расчётные ве-

личины, входящие в список доступных результатов. Например, инте-
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рес могут представлять остаточные пластические деформации: Nodal 

Solution>Plastic Strain>von Mises Plastic strain. 

19.2. Включить анимацию изображения результатов расчёта. 

Нажимаем кнопку Animate Results (анимация результатов) в панели 

«Result Viewer». 

При этом появляется новая диалоговая панель, где в разделе «Type of 

Animation Sequence to Capture» в качестве типа анимации следует 

указать Over time (по времени), OK. 

В следующем окне в поле «Number of animations frames» (количество 

кадров анимации) вводим число в интервале от 10 до 100 (чем боль-

ше кадров, тем более плавной будет анимация, но более затратным 

будет процесс записи видео файла), в поле «Animation time delay» 

(время задержки между кадрами, сек) вводим 0.1 и в списке «Contour 

data for animation» выбираем Use Last Display (использовать послед-

нее изображение) либо другую выходную величину. 

Нажатие кнопки OK приводит к формированию и отображению на 

экране анимированного представления выбранной величины. 

20. Для отчёта по работе записать в файл протокол команд базы данных: 

U_M>File>Write DB Log File. 

Вводим имя Lab8.lgw. 

21. Выйти из программы: ANSYS Toolbar>QUIT. 
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9 МОДЕЛИРОВАНИЕ  ШТАМПОВКИ  ПРОФИЛЯ  
ЭЛАСТИЧНЫМ  ИНСТРУМЕНТОМ   
В  СРЕДЕ  CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: для штамповки профиля уголкового сечения ис-

пользуется дюралевая заготовка в виде полосы шириной 60 мм и толщиной 

1,5 мм. Штамп состоит из жёсткого пуансона и эластичной матрицы (подуш-

ки), помещённой в закрытый контейнер (рисунок 9.1). Материал заготовки – 

Д16Т ( 47 10E = ⋅ МПа; 0,3µ = ; в 440σ = МПа; 0,2 260σ = МПа; т 1000E = МПа). 

Материал эластичной матрицы – полиуретан СКУ-7Л (константы двухпара-

метрической модели гиперупругого материала Муни-Ривлина 10 4,5c = МПа и 

01 2,5c = МПа; коэффициент Пуассона 0,49ν = ). Коэффициент трения между 

пуансоном и заготовкой составляет 0,05, а между матрицей и заготовкой – 

0,1. 

Допущения: пуансон считается абсолютно жёстким; ввиду большой 

протяжённости конструкции рассматривается случай плоской деформации. 

Цель: выполнить моделирование операции штамповки при помощи жё-

сткого пуансона и гиперупругого материала; определить усилие штамповки; 

рассчитать упругое пружинение. 
 

 
Рисунок 9.1 – Поперечное сечение штампа 
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Благодаря симметрии конструкции здесь можно ограничиться модели-

рованием лишь половины сечения. 

Для решения задачи предлагается выполнить следующие действия. 

1. Запустить пакет ANSYS, указать имя задачи Lab9. 

2. Установить тип используемых в расчёте конечных элементов – 8-узловой 

плоский элемент PLANE183 с формулировкой «плоская деформация»: 

M_M>Preprocessor>Element Type>Add/Edit/Delete. 

Нажимаем Add и выбираем  Structural Solid>Quad 8node 183, OK. 

В окне «Element types» нажимаем Options и для опции K3 устанавливаем 

значение Plane Strain. 

Далее OK и Close. 

3. Задать свойства материала: M_M>Preprocessor>Material Props>Material 

Models. 

Сначала определяем первую модель материала для Д16Т. 

В правом окне последовательно выбираем Structural>Linear>Elastic>  

Isotropic. 

Вводим: 

EX: 7e4 (модуль упругости, МПа) 

PRXY: 0.3 (коэффициент Пуассона) 

OK. 

Далее для задания нелинейных свойств выбираем билинейную модель де-

формирования с изотропным упрочнением: Structural>Nonlinear>  

Inelastic>Rate Independent>Isotropic Hardening Plasticity>Mises Plasticity> 

Bilinear. 

Вводим: 

 Yield Stss: 260 (предел текучести, МПа) 

 Tang Mod: 1000 (касательный модуль, МПа) 

OK. 

Для полиуретана СКУ-7Л следует выбрать модель гиперупругого мате-

риала Муни-Ривлина, причём при деформациях, не превышающих 100%, 

можно ограничиться двухпараметрической моделью. 

В меню диалоговой панели указываем  Material>New model. 

Используем «Define Material ID»: 2, OK. 

Последовательно выбираем Structural>Nonlinear>Elastic>Hyperelastic> 

Mooney-Rivlin>2 parameters. 
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Вводим: 

C10: 4.5 (константа материала Муни-Ривлина 10c , МПа) 

C01: 2.5 (константа материала Муни-Ривлина 01c , МПа) 

d: 2.857e-3 (параметр несжимаемости материала, МПа-1) 

OK. 

Следует отметить, что параметр несжимаемости материала рассчитывает-

ся по формуле 

3

10 01

1 2 1 2 0,49
2,857 10

4,5 2,5
d

c c

ν −− − ⋅= = = ⋅
+ +

МПа-1. 

Для полностью несжимаемого материала 0d = , поскольку 0,5ν = . 

Закрываем панель. 

4. Построить прямоугольники, описывающие сечения заготовки и эластич-

ной матрицы: M_M>Preprocessor>Modeling>Create>Areas>Rectangle>By 

2 Corners. 

Для первого прямоугольника вводим следующие параметры: координаты 

левого нижнего угла WP X = WP Y = 0; ширина Width = 50; высота 

Height = 50. Нажимаем  Apply. 

Для второго прямоугольника: WP X = 0; WP Y = 50; ширина Width = 30; 

высота Height = 1.5, OK. 

5. Для удобства ввода исходных данных определить скалярные параметры: 

U_M>Parameters>Scalar Parameters. 

В поле «Selection» последовательно вводим: r=2.8; alf=44*3.14159/180; 

a=r*(1/SIN(alf)-1); b=21/TAN(alf). После каждого ввода здесь необходимо 

нажать кнопку Accept (принять). 

Закрываем панель кнопкой Close. 

6. Построить две точки: M_M>Preprocessor>Modeling>Create>Keypoints>In  

Active CS. 

Вводим координаты точек (используя скалярные параметры) согласно 

следующей таблице: 

 

Номер  
точки 

x, 
мм 

y, 
мм 

z, 
мм 

9 0 51.5-a 0 
10 21 51.5+b-a 0 
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Включаем нумерацию геометрических объектов: U_M>PlotCtrls>  

Numbering, отмечаем флаги «Keypoint numbers», «Line numbers» и «Area 

numbers». 

7. Соединить построенные на предыдущем шаге точки прямой линией: 

M_M>Preprocessor>Modeling>Create>Lines>Lines>Straight Line. 

Указываем точки 9 и 10, OK. 

8. Создать зеркальное отображение построенной на предыдущем шаге ли-

нии: M_M>Preprocessor>Modeling>Reflect>Lines. 

Указываем линию L9, OK. 

Используем следующие значения: 

 «Plane of symmetry»: Y-Z plane X (плоскость симметрии) 

 «Existing lines will be»: Copied (исходные линии будут копироваться) 

OK. 

9. Склеить две линии, представляющие границы сечения пуансона: M_M> 

Preprocessor>Modeling>Operate>Boolean>Glue>Lines. 

Указываем линии L9 и L10, OK. 

10. Построить дугу скругления в вершине сечения пуансона: M_M>  

Preprocessor>Modeling>Create>Lines>Line Fillet. 

Указываем линии L9 и L11, OK. 

В поле «Fillet radius» вводим значение радиуса скругления (в мм): 2.8, OK. 

11. Разбить дугу на две равные части: M_M>Preprocessor>Modeling> 

Operate>Boolean>Divide>Lines w/ Options. 

Указываем дугу скругления (т.е. линию L10), OK. 

Используем следующие значения: 

 «Ratio of line lengths»: 0.5 (отношение длин линий) 

 «Existing line will»: Be modified (исходная линия будет удалена) 

OK. 

12. Удалить две линии, представляющие левую границу сечения пуансона: 

M_M>Preprocessor>Modeling>Delete>Line and Below. 

Указываем линии L11 и L12, OK. 

13. Задать атрибуты элементов: M_M>Preprocessor>Meshing>MeshTool. 

В разделе «Element Attributes» диалоговой панели «MeshTool» в выпа-

дающем списке выбираем Areas и нажимаем распложенную правее кноп-

ку Set. 

Указываем поверхность сечения заготовки (т.е. A2), OK. 

Вводим атрибуты заготовки: 
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 «Material number»: 1 (номер материала) 

 «Element type number»: 1 PLANE183 (номер типа элементов) 

Apply. 

Далее указываем поверхность сечения эластичной матрицы (т.е. A1), OK. 

Для матрицы меняем только материал: 

 «Material number»: 2 

OK. 

14. Разбить поверхности на конечные элементы: M_M>Preprocessor> 

Meshing>MeshTool. 

Нажимаем кнопку Set строки «Lines» и указываем вертикальные кромки 

поверхности A2, OK. 

В поле «No. of element divisions» (число делений на элементы) вводим зна-

чение 3, Apply. 

Далее указываем горизонтальные кромки этой же поверхности, OK. 

В поле «No. of element divisions» вводим число 20, а в поле «Spacing Ratio» 

для построения неравномерной сетки – число 3, Apply. 

Затем указываем все четыре кромки поверхности A1, OK. 

В поле «No. of element divisions» вводим число 30, а в поле «Spacing Ratio» 

– число 5, OK. 

Отметим, что для некоторых линий сгущение сетки здесь следует поме-

нять на обратное, так чтобы размеры элементов уменьшались снизу вверх, 

справа налево. 

Нажимаем кнопку Flip строки «Lines» и указываем те линии, для которых 

данное условие не выполняется, OK. 

В поле «Shape» указываем Quad (четырёхугольная) и выбираем режим 

Mapped (регулярная сетка). 

Нажимаем кнопку Mesh и для выбора всех поверхностей Pick All. 

Получаемая здесь разбивка представлена на рисунке 9.2. 

15. Создать контактную пару для описания взаимодействия абсолютно жёст-

кого пуансона и деформируемой загатовки. 

Для этого сначала запускаем специальный инструмент «Contact Manager» 

(Менеджер контактов) путём нажатия одноимённой кнопки пиктографи-

ческого меню программы ANSYS либо командой M_M>Preprocessor> 

Create>Contact Pair. 
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Рисунок 9.2 – Конечно-элементная модель 

 

В появившейся панели нажимаем первую кнопку, предназначенную для 

вызова средств Мастера контактов «Contact Wizard» и выполняем сле-

дующие шаги. 

15.1. Указать ответную поверхность. 

В разделе «Target Surface» в качестве объектов, используемых для оп-

ределения ответной поверхности, выбираем Lines. 

В разделе «Target Type» указываем Rigid w/Pilot (абсолютно жёсткая с 

ведущим, или "пилотным", узлом). 

Нажимаем кнопку Pick Target и указываем две линии, представляю-

щие правую границу сечения пуансона (т.е. L9 и L10), Apply. 

Нажимаем Next для перехода к следующему шагу. 

15.2. Определить положение ведущего узла. 
Выбираем опцию «Create an extra node in active CS» для явного указа-

ния местоположения узла в активной системе координат. 

Ниже вводим координаты (в мм): X = 0; Y = 75; Z = 0. 

Нажимаем Next для перехода к следующему шагу. 

15.3. Указать контактную поверхность. 

В разделе «Contact Surface» в качестве объектов, используемых для 

определения контактной поверхности, выбираем Lines. 

В разделе «Contact Element Type» выбираем Surface-to-Surface (по-

верхность – поверхность). 

Нажимаем кнопку Pick Contact и указываем верхнюю кромку поверх-

ности A2,  Apply. 
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В диалоговой панели Мастера контактов нажимаем кнопку Next для 

перехода к следующему шагу. 

15.4. Задать параметры контакта. 

Для коэффициента трения в поле «Coefficient of Friction» вводим зна-

чение 0.05. 

И наконец, для создания собственно контактной пары нажимаем 

кнопку Create. 

15.5. Изменить направление нормалей. 

В конце появляется информационное окно, где констатируется факт 

создания контактной пары, указывается номер связанного с ней набо-

ра реальных постоянных и отмечается необходимость визуальной 

проверки на экране ориентации внешних нормалей к контактной и от-

ветной поверхностям. Нормали к этим поверхностям должны указы-

вать друг на друга. 

Можно заметить, что в нашем случае нормаль к дуге скругления на-

правлена неправильно. 

Для изменения направления нормалей ответных элементов нажимаем 

кнопку Flip Target Normals и указываем дугу (т.е. линию L10), OK. 

Завершается процесс создания контактной пары нажатием кнопки  

Finish. 

16. Создать контактную пару для описания взаимодействия заготовки и эла-

стичной матрицы. 

Снова открываем Мастер контактов «Contact Wizard» и выполняем сле-

дующие шаги. 

16.1. Указать ответную поверхность. 

В разделе «Target Surface» в качестве объектов, используемых для оп-

ределения ответной поверхности, выбираем Lines. 

В разделе «Target Type» указываем Flexible (деформируемая). 

Нажимаем кнопку Pick Target и указываем нижнюю кромку поверх-

ности A2, Apply. 

Отметим, что за ответную поверхность здесь мы выбираем более жё-

сткую. 

Нажимаем Next для перехода к следующему шагу. 

16.2. Указать контактную поверхность. 

В разделе «Contact Surface» в качестве объектов, используемых для 

определения контактной поверхности, выбираем Lines. 
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В разделе «Contact Element Type» выбираем Surface-to-Surface. 

Нажимаем кнопку Pick Contact и указываем верхнюю кромку поверх-

ности A1,  Apply. 

Нажимаем Next для перехода к следующему шагу. 

16.3. Задать параметры контакта. 

Для коэффициента трения в поле «Coefficient of Friction» вводим зна-

чение 0.1. 

Для завершения процесса создания контактной пары последовательно 

нажимаем кнопки Create и Finish. 

В конце следует закрыть диалоговую панель Менеджера контактов. 

17. Задать граничные условия. 
Воспользуемся командой задания перемещений на линиях M_M> Solu-

tion>Define Loads>Apply>Structural>Displacement>On Lines. 

Указываем левую кромку поверхности A2 и обе вертикальные кромки по-

верхности A1, OK. 

В поле «DOFs to be constrained» выбираем UX, Apply. 

Далее указываем нижнюю кромку поверхности A1, OK. 

В поле «DOFs to be constrained» выбираем UY, OK. 

Следует отметить, что абсолютно жёсткие элементы пуансона закрепля-

ются автоматически по всем степеням свободы, для которых явно не зада-

ны перемещения. 

18. Задать нагрузку. 
В качестве нагрузки в рассматриваемой задаче выступает вертикальное 

перемещение пуансона (рабочий ход). 

Глубину внедрения пуансона в подушку можно рассчитать по следующей 

эмпирической формуле: 

6 3 6 1,5 12H r s= + = + ⋅ = мм, 

где 3r ≈ мм – радиус скругления внутреннего угла профиля; 1,5s= мм – 

толщина заготовки. 

Для задания перемещений в узлах выбираем команду M_M>Solution>  

Define Loads>Apply>Structural>Displacement>On Nodes. 

Указываем ведущий узел жёсткого элемента, лежащий на оси симметрии 

(самый верхний узел). OK. 

В списке «DOFs to be constrained» выбираем UY, а в поле «Displacement 

Value» вводим отрицательное число (в мм): -12.  

OK. 
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19. Задать опции первого шага нагружения (рабочий ход пуансона): M_M> 

Solution>Analysis Type>Sol’n Controls. 

Настоящая задача является геометрически и физически нелинейной, по-

этому для учёта больших перемещений (и деформаций) в списке «Analysis 

Options» выбираем значение Large Displacement Static. 

Время в конце первого шага нагружения (поле «Time at end of loadstep» 

раздела «Time Control») задаём равным 1. 

В поле «Number of substeps» того же раздела вводим число подшагов: 200. 

Для сохранения промежуточных результатов на каждом подшаге в списке 

«Frequency» (частота записи выходных величин в файл результатов) вы-

бираем значение Write every substep. 

OK. 

20. Записать первый шаг нагружения в файл: M_M>Solution>Load Step Opts> 

Write LS File. 

В поле «Load step file number» (номер файла шага нагружения) вводим 

число 1, OK. 

При этом данные по первому шагу нагружения будут записаны в тексто-

вый файл Lab9.s01. 

21. Сохранить базу данных: ANSYS Toolbar>SAVE_DB. 

База данных записывается в файл  Lab9.db. 

22. Задать опции второго шага нагружения (обратный ход пуансона): 

M_M>Solution>Analysis Type>Sol’n Controls. 

Время в конце второго шага нагружения задаём равным 2 (поле «Time at 

end of loadstep»). 

В поле «Number of substeps» вводим число подшагов: 50, OK. 

23. Снять нагрузку. 
Для задания перемещений в узлах выбираем команду M_M>Solution>  

Define Loads>Apply>Structural>Displacement>On Nodes. 

Указываем ведущий узел жёсткого элемента, лежащий на оси симметрии 

(самый верхний узел). OK. 

В списке «DOFs to be constrained» выбираем UY, а в поле «Displacement 

Value» вводим 0, OK. 

24. Записать второй шаг нагружения в файл: M_M>Solution>Load Step Opts> 

Write LS File. 

В поле «Load step file number» вводим номер 2, OK. 
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При этом данные по второму шагу нагружения будут записаны в тексто-

вый файл Lab9.s02. 

25. Запустить задачу на счёт: M_M>Solution>Solve>From LS Files. 

Данная команда позволяет получить решения сразу для нескольких шагов 

нагружения, информация по которым считывается из файлов. 

В соответствующие поля вводим: 

«Starting LS file number»: 1 (номер начального файла шага нагружения) 

«Ending LS file number»: 2 (номер конечного файла шага нагружения) 

«File number increment»: 1 (приращение номеров файлов) 

OK. 

Возможные сообщения о том, что некоторые элементы становятся сильно 

искажёнными, следует игнорировать нажатием кнопки Proceed (продол-

жить). 

26. Запустить специальный инструмент «Results Viewer», предназначенный 

для пошагового просмотра результатов расчёта: M_M>General Postproc> 

Results Viewer. 

26.1. Изобразить поле напряжений по Мизесу. 

В списке результатов выбираем Nodal Solution>Stress>von Mises 

stress  и нажимаем кнопку Plot Results. 

Далее, перемещая движок по полосе подшагов, можно наблюдать 

картину изменения величины эквивалентного напряжения в различ-

ные моменты времени в рассчитанном интервале. 

Поле напряжений по Мизесу в конце первого шага показано на ри-

сунке 9.3. 

26.2. Включить анимацию изображения результатов расчёта. 

Нажимаем кнопку Animate Results (анимация результатов) в панели 

«Result Viewer». 

При этом появляется новая диалоговая панель, где в разделе «Type of 

Animation Sequence to Capture» в качестве типа анимации следует 

указать Over time (по времени), OK. 

В следующем окне в поле «Number of animations frames» (количество 

кадров анимации) вводим число в интервале от 10 до 100 (чем боль-

ше кадров, тем более плавной будет анимация, но более затратным 

будет процесс записи видео файла), в поле «Animation time delay» 

(время задержки между кадрами, сек) вводим 0.1 и в списке «Contour 
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data for animation» выбираем Use Last Display (использовать послед-

нее изображение) либо другую выходную величину. 

Нажатие кнопки OK приводит к формированию и отображению на 

экране анимированного представления выбранной величины. 

 

 
Рисунок 9.3 – Поле напряжений по Мизесу (в МПа)  

в конце первого шага нагружения 
 

27. Определить усилие штамповки. 

Входим в постпроцессор истории нагружения: M_M>TimeHist Postpro. 

Для задания новой переменной нажимаем кнопку Add Data. 

В древовидной структуре «Result Item» последовательно указываем  

Reaction Forces>Structural Forces>Y-Component of force (реакция по 

оси Y ). 

В поле «Variable Name» вводим имя Ry. OK. 

Далее на экране мышью указываем ведущий узел жёсткого пуансона. OK. 

С помощью калькулятора определим новую переменную. 

В первом поле калькулятора перед знаком равенства вводим имя P. 

После знака равенства вводим число -2  и нажимаем кнопку умножения 

калькулятора. После этого из списка калькулятора выбираем Ry. Заверша-

ем ввод нажатием кнопки Enter. 

Далее выбираем переменную P и нажимаем кнопку Graph Data. 

Получаемый в этом случае график показан на рисунке 9.4. Видно, что мак-

симальное значение усилия здесь составляет 557 Н/мм. 
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Рисунок 9.4 – Зависимость погонного усилия пресса от времени (в Н/мм) 
 

28. Рассчитать упругое пружинение. 
Данный шаг связан с модификацией модели, поэтому сначала здесь следу-

ет сохранить базу данных: ANSYS Toolbar>SAVE_DB. 

Для изменения геометрии конечно-элементной модели путём добавления 

к координатам узлов найденных перемещений используем команду M_M> 

Preprocessor>Modeling>Update Geom. 

Вводим: 

 «Scaling factor»: 1 (коэффициент масштабирования) 

 «Load step»: LAST (шаг нагружения – последний) 

 «Substep»: LAST (подшаг – последний) 

 «Filename, Extension, Directory»: Lab9.rst (файл результатов) 

OK. 

Далее отрисовываем модифицированную сетку элементов: U_M>Plot> 

Elements. 

Для определения угла наклона полки профиля выбираем команду 

U_M>List>Picked Entities +. 

В появившемся окне устанавливаем опции: 

 «Query Item»: Distance Betwn (вид запроса – расстояние между) 

 «On Entities»: 2 Nodes (объекты – два узла). 

В графическом окне указываем два узла на внутренней поверхности полки 

профиля, OK: 

The distance between nodes    2863 and    2897 in coordinate system     0 is: 
   DIST              DX (ND2-ND1)      DY (ND2-ND1)      DZ (ND2-ND1) 
24.28913414      -17.46738999      -16.87756868       0.000000000 
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Фактический угол наклона полки профиля будет равен 

o17,467
arctg arctg 46

16,878

DX

DY
α = = ≈ . 

Отметим, что в данном случае упругое пружинение может быть вычисле-

но как разность между углом, образованным полками профиля, и углом 

пуансона: 
o o2 88 2 46 88 4γ α= − = ⋅ − = . 

В конце следует восстановить исходную модель: ANSYS Toolbar> 

RESUME_DB. 

29. Для отчёта по лабораторной работе записать в файл протокол команд базы 

данных: U_M>File>Write DB Log File. 

Вводим имя Lab9.lgw. 

30. Выйти из программы: ANSYS Toolbar>QUIT. 
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10 МОДЕЛИРОВАНИЕ  ОБРАБОТКИ  ПОВЕРХНОСТИ  
ДЕТАЛИ  МЕТОДОМ  ВЫГЛАЖИВАНИЯ1   
В СРЕДЕ  CAE-СИСТЕМЫ  ANSYS 

 

Исходные данные: моделируемая часть детали представляет собой 

прямоугольную область размером 3х2 мм (рисунок 10.1). Выглаживающий 

инструмент имеет алмазную головку (индентор) радиусом 2 мм. Материал 

детали – сталь 12Х2Н4А ( 52 10E = ⋅ МПа; 0,3µ = ; 12%δ = ; пц 710σ = МПа; 

0,2 800σ = МПа; в 1000σ = МПа), нелинейный участок диаграммы деформиро-

вания которой представлен табличной зависимостью напряжения от пласти-

ческой деформации (таблица 10.1). На первом этапе производится внедрение 

индентора в деталь на глубину 10 мкм, на втором – индентор перемещается 

вдоль поверхности детали на расстояние 1 мм. При этом коэффициент трения 

составляет 0,1. 

Допущения: индентор считается абсолютно жёстким; рассматривается 

случай плоской деформации. 

Цель: исследовать распределение пластических деформаций после вне-

дрения индентора, а также в процессе выглаживания; определить усилия 

внедрения индентора и выглаживания. 

 

 
Рисунок 10.1 – Расчётная схема задачи 

                                           
1 Выглаживание – это один из современных высокопроизводительных методов финишной обработ-

ки поверхностей деталей, приводящий к уменьшению шероховатости поверхности и упрочнению поверхно-

стного слоя. 

1u = мм 

10v = мкм 

R2 R2 

1 

2 

3 
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Таблица 10.1 – Зависимость напряжения от пластической деформации 

№ pε , % σ , МПа 

1 0 710,0 

2 0,1 780,1 

3 0,2 796,0 

4 0,3 803,8 

5 0,4 808,8 

6 0,5 812,6 

7 0,6 815,7 

8 0,7 818,5 

9 0,8 820,9 

10 0,9 823,2 

11 1,0 825,3 

12 12 1000 

 

Рекомендации:  

1. Для построения модели использовать элементы PLANE183 с форму-

лировкой «плоская деформация». 

2. Для задания нелинейных свойств материала выбрать полилинейную 

модель деформирования Мизеса с изотропным упрочнением. 

3. Отметим, что для получения достоверных результатов размер эле-

ментов в поверхностном слое здесь не должен превышать 10 мкм. Однако в 

учебных целях, учитывая высокую трудоёмкость задачи, можно ограничить-

ся сеткой 50х30 со сгущением к верхней границе моделируемой области (па-

раметр «Spacing Ratio» принять равным 10). 

4. В качестве граничных условий задать условия симметрии на нижней 

и правой границах исследуемой области детали. 

5. Для моделирования индентора использовать жёсткий контактный  

элемент с ведущим узлом. 

6. При задании опций анализа выбрать статический анализ с учётом 

больших перемещений (Large Displacement Static), при этом для первого шага 

нагружения, соответствующего внедрению индентора, принять: 

«Time at end of loadstep» = 1; 

«Number of substep» = 100, 

а для второго шага, моделирующего процесс выглаживания, задать: 

Time at end of loadstep» = 2; 
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«Number of substep» = 300. 

7. Для пошагового просмотра результатов расчёта использовать «Result 

Viewer». 

8. Изобразить поле интенсивности пластических деформаций (Plastic 

strain intensity) в конце первого шага нагружения, т.е. после внедрения ин-

дентора. 

9. Включить анимацию изображения поля интенсивности пластических 

деформаций по времени (параметру нагружения). 

10. Для определения усилий внедрения индентора и выглаживания при 

помощи постпроцессора истории нагружения построить зависимости реак-

ций ведущего узла жёсткого индентора от времени. 

11. Для отчёта по работе записать в файл Lab10.lgw протокол команд 

базы данных. 

 

 


